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About InField and This Guide

InField is a Windows® based software tool for management, control, and graphical analysis of engineering test
data. InField features:

« Options to select and validate multiple data channels from different locations, files, and file formats

* Results can be saved and translated to a number of different file formats and exported to other software
programs, such as to a spreadsheet in Microsoft® Excel

« A comprehensive set of data validation tools

Selecting Data

Data can be selected from a number of different file formats.These formats include *.S1F,*_RSP, * .DAC, * . ASC,
* _TXT,*_.DAT, *.CYH, *.TH, *_.PV, *_MD, *.1D, *.2D, and * _MAT.

Viewing Data

Data can be viewed as sequential plots, bar charts, color histograms, X-Y plots, and tables (depending on the type
of data within the Channels List.) Sequential and histogram plots can be zoomed (enlarged).

Sequential channels can be plotted in individual windows (Single Plot), superimposed in one plot window (Over
Plot), or grouped together in one plot window (Multi Plot).

A single data point can be selected, and its numerical coordinates can be viewed using a crosshair pointer.

When enlarging a section of a plot, a scroll function will be available to view data on either side of the enlarged
portion.

Editing Data

The InField edit functions are used primarily with sequential data. Options are available to cut, copy, and paste
selected data to and from other programs. Options are also available to rescale and offset plots, interpolate a
section of data, or replace a section of data with a specific value.

Data Validation

InField includes a variety of data validation tools used to verify that good data has been collected when working
either in the field or in-house.These can be used to save time and reduce the need to perform multiple tests due
to: data that was collected improperly, full-scale ranges that weren't calibrated and caused missed data points, or
faulty transducers that may not work or work intermittently.

In addition, these tools can be used to filter out unnecessary data that has been collected, leaving only the most
useful data for analysis. One such case may be when looking for an anomaly, where a particular range, or group
of data values, is causing the most significant amount of damage. Using one of the DataModes within InField
simplifies searching for these situations.

About InField and This Guide » page 1



Exporting Data

Selected channels can be saved to a file using the Save As command. If a particular data format is required, simply
select the format from the list of file formats supported in InField. Currently InField supports *.SIF, *.RSP,
*_DAC,*_.CYH, *_ASC, * . TXT, * .MAT, *.CHL and *.WRK. Data and Metadata (header values) may also be copied
to the Windows Clipboard.

Exporting Plots

InField can also be used to export plots to either a file or the Windows Clipboard. The following options are
available when exporting plots:
 Enhanced Metafile — Used to save data as an Enhanced Metafile. This option allows saving data directly to
the Windows Clipboard or to a new file.
* Windows Bitmap — Used to save data as a Windows Bitmap. This option allows saving data directly to the
Windows Clipboard or to a new file.

« InField Plot Script — Used to save a script describing the current plot for playback at a future time.

About this Manual

The primary purpose of this manual is to introduce InField and provide information on how to use its many
features. This manual is intended for engineers, scientists, technicians, and others who want to use InField to
display and report test data.

A basic working knowledge of Microsoft Windows is an important prerequisite for installing and using InField. For
those not familiar with using Windows, completion of the tutorials provided with the Windows operating system
is suggested.

Contents of this Manual
The contents of the sections in this operating manual are:

About InField and This Guide
Provides an overview of InField and describes the most basic information about InField.

Installation
Presents the install procedure for InField and describes the computer requirements to run InField.

Start-up and Main Window
Describes starting and exiting Infield, the InField main window, and the Channels List window.

Selecting Data
Covers selecting channels from the Channels List and selecting data or a data set for plotting or validation.
Understanding the concepts presented in this chapter are important, as they are fundamental in the use of
InField.

Viewing Data
Describes the various methods to display and manipulate channel data.

Editing Data
Explains how to edit data in plot displays. It provides information needed to perform activities described in
later sections.
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Saving Data Files
Describes the procedure for saving data to a file or other programs.

Validation Tools
Introduces the data validation tools provided in InField.

DataModes
Describes the various DataModes available within InField and the correct procedures and practical
application of these tools.

Fatigue Calculator
Describes the use of the Fatigue Calculator analysis tools available within InField.

Frequency Analysis
Describes the use of the Frequency Analysis tools available within InField and the correct procedures for
use with these tools.

Filtering
Describes the use of the Filtering tools available within InField and the correct procedures for use with
these tools.

Conventions Used
Standard engineering abbreviations and the the following conventions are used throughout this manual.

The figures and instructions in this manual are based on the use of InField with Windows 2000, except as noted.

The InField functions and their operation are the same regardless of the version of Windows used, although
certain visual aspects of the dialog boxes and windows may differ.

File names and information to be entered exactly as presented will be presented in a fixed-width font to
differentiate it from the descriptive information found in this manual.
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Installation

Computer Requirements
The following are the minimum computer requirements for the installation of InField.

« Microsoft® Windows® 98 Second Edition, Windows NT 4.0 with Service Pack 6a* and Internet Explorer
5 or greater, Windows 2000, Windows XP

« Pentium® class PC (300 MHz or higher recommended)
¢ 32 MB RAM (64 MB recommended)

* 50 MB free disk space

« 16 bit (or higher) color display

* CD-ROM Drive

e Mouse or other pointing device

* Service Pack 6a can be found at www.microsoft.com.

Software Installation

You should be familiar with the Windows operating system before starting this procedure. If you are not, complete
the tutorial available in the Windows Help System.

Installation Procedure

Use the following procedure to install InField. Administrator rights must be available before installing InField on a
Windows NT, 2000, or XP system.

1
2
3.
4

Start Windows (if it is not already running).
Insert the InField CD.
In the Start menu, select Run... or use the Windows Add/Remove Program control panel.

In the command line text box of the Run dialog box, type in d:\InField.exe, where d is the drive letter
for the CD-ROM. Press Enter.

The installation is completed by InstallShield® Wizard, which will guide you through the process.To continue the
process, select the Next > button at each dialog box.To return to a previous action, select the < Back button.

The installation process can be cancelled at any time. Simply select the Cancel button at any installation dialog
box, and InstallShield® will remove the files installed thus far on your hard drive.
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5. When you are prompted for a destination location, select the default unless it is necessary to use a different
destination.

To specify another destination, click Browse..., specify the directory to use via the dialog box, and continue the
process.

6. At the Setup Complete dialog box, select the Finish button to complete the installation. Restart your
computer if prompted to do so at this time.

InField will now appear in the Programs section of the Start menu.

The first time InField is run, you will be prompted to enter a password. This will either be included with the CD
or can be obtained by contacting SoMat at (217) 328-5359 or sales@somat.com.

Re-Installation of InField

If InField should require re-installation, simply run the installation program (InField.exe) again. Click yes to the
prompt that appears asking to un-install InField. Click Yes to all dialog boxes that appear during the un-install. Any
data files or scripts generated WILL NOT be deleted. All user configuration settings WILL be deleted. After un-
installation is complete, run the installation program again to re-install.
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Start-up and Application Window

This section describes starting up and exiting InField, the InField main window, the various menu commands, and
the toolbar.

Starting InField
Select InField from the Windows Start menu to start the program.

If InField is used frequently, find the file InField.exe in the subdirectory where InField was installed and create a
shortcut. This is done be right-clicking the icon and selecting Create Shortcut from the menu that appears. This
shortcut can then be placed on the desktop for easy access.

Passwords

A password is required the first time InField is started.This password is either included with the CD if InField was
purchased from a SoMat Sales Representative or through a Sales Representative if InField was downloaded from
the Internet.
The following image shows the password entry window without a password. Enter the password then click OK
to continue.

iy, InField License Options |

Fazsword

Licensed to:
Company:

Werzion;

Help Caricel (] %

Password Entry Window

Quitting InField
To quit InField, use one of the following:
« Select Exit from the File menu
e Press ALT+F4 (this is a standard Windows command to quit a program)

« Click on the Window Close button, %I, in the title bar.

« Click on the InField icon or control menu box at the left end of the title bar, and then select Close from
the drop-down menu

Start-Up and Application Window e page 6



InField Application Window

The InField application window shown below has the title bar, menu bar, toolbar, and status bar like many other
Windows-based applications. Also shown in the main work area is the Channels List window, in which channels

are loaded and selected for display or verification.

> SoMat InField Developer - ¥ersion 1.0.0
Wfindow  Help

File Edit Display Procedures Tools

225 28| /el /ol
I[=] FS

=k [active] Channels List
vel=e] sl -
Filename | Chan Marne | Run # | [ataMode Type | Diirsctory |

Channels List | Dutput List

ChanListd

InField Main Window
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Channels List Window

Channels List tab

The Channels List tab contains all new data channels once loaded into InField. They can be plotted or validated
using the various tools accessible from the menu system and the toolbars of the Channels List window and the
main InField window.

=k [Active] Channels List -0l x|
?|?|§|| H:Ft| |i§f|b°‘ﬂ 7<| |Show.&|l
Filenarne | Chan Mame | Run # D atabdode Type Directary -
Spikes. sif Strain_al 1 TIMHIS C:\Program FileshS obd athlnField\E xamples
Spikes. sif Strain_a23 1 TIMHIS C:\Program FileshS obd athlnField\E xamples
Spikes. sif Strain_bE 1 TIMHIS C:\Program FileshS obd athlnField\E xamples
SpaceTruss sif Faorce Channel 1 TIMHIS C:\Program FileshS obd athlnField\E xamples
SpaceTruss sif Rezponze Channel 1 TIMHIS C:\Program FileshS obd athlnField\E xamples
ShockData. sif 1gSquarePulze 1 TIMHIS C:\Program FileshS obd athlnField\E xamples
Sae. sif SAE_Bracket 1 THist C:\Program FileshS obd athlnField\E xamples
Sae. sif SAE_Suzpension 1 THist C:\Program FileshS obd athlnField\E xamples
Sae. sif SAE_Transmiszsion 1 THist C:\Program FileshS obd athlnField\E xamples
RunlpdndDown, sif Timed_Tachl RM_1 1 TIMHIS C:\Program FileshS obd athlnField\E xamples
RunlpdndDown, sif Time3_MiczZ RM_1 1 TIMHIS C:\Program FileshS obd athlnField\E xamples
RunlpdndDown, sif Time2_Accel3.RMN_1 1 TIMHIS C:\Program FileshS obd athlnField\E xamples
RunlpdndDown, sif Time1_Acceld. RMN_1 1 TIMHIS C:\Program FileshS obd athlnField\E xamples
FrequencyD ata.sif 10V Sinedta0 1 TIMHIS C:\Program FileshS obd athlnField\E xamples
FrequencyD ata.sif BWCoSinedt100 1 TIMHIS C:\Program FileshS obd athlnField\E xamples j
Channels List | Dutput List

Channels List Window

Output List tab

The Output List tab contains any analysis or validation channels created from filters or DataModes will be located
and is accessed by clicking on the Output List tab located at the bottom of the Channels List window. These new
channels can be manipulated in the same fashion as those in the Channels List tab.

=k [Active] Output Channels List |0l x|

bl =] = S e ]
Filename | Chan Mame | Run # | Datatode Tope | Directory |
Rainflow_000. gif Responge Channel 1 RAMFLw C:AProgram FileshS obd athlnFields O utputFiles
Peaki alleybd atrix_000, if Strain_bdd 1 FuaTR C:AProgram FileshS obd athlnFields O utputFiles
Peaki alleybd atrix_000, if Strain_d47 1 FuaTR C:AProgram FileshS obd athlnFields O utputFiles
TimeHisto_ 000, =i Strain_bdd 1 TIMHIS C:AProgram FileshS obd athlnFields O utputFiles
TimeHisto_ 000, =i Elapzed 1 TIMHIS C:AProgram FileshS obd athlnFields O utputFiles
Timeatlewyel 000, gif Strain_chE 1 TIMLEY C:AProgram FileshS obd athlnFields O utputFiles
Filter_ 000, zif Strain_d47.f 1 TIMHIS C:AProgram FileshS obd athlnFields O utputFiles
AutoP ower_ 000, =i Strain_bg 1 AUITOFWR C:AProgram FileshS obd athlnFields O utputFiles
Rainflow_007.gif 1g5SquarsPulze 1 RAMFLw C:AProgram FileshS obd athlnFields O utputFiles

1 RAMFLw C:Program Fil obd athlnFields O utputFiles

Channels List  Qutput List

Output List Window
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InField Menus

The menu bar contains the available menu selections. Descriptions of the commands and options available within
each of these menus follows.

File Menu

Open — Open test data files. The dialog that opens is a standard Windows File Open dialog; use this window to
locate and open the files requiring viewing and analysis. The different file types available for use in InField
can be selected by using the down arrow to the right of the Files of type drop-down list. Channels will
be placed into the Channels List.

Save As — Save channels selected in the Channels List or active plot window to a new data file. The window that
opens will be a standard Windows File Save dialog. Select the file type from the Save As Type drop-down
list before clicking Save to ensure the file is saved in the proper format.

Export Plot — Export a plot either to a file or to the Windows Clipboard.
Print — Print plots or tables.
Exit — Close InField in a controlled manner.

Recent Data Files — Show the most recent data files opened within InField.

Edit Menu
Copy — Export the Channels List as text to the Windows Clipboard.

Select All — Select all of the channels in either the Channels List or the Output List. Although using the mouse to
highlight all of the channels would work, using Select All (CTRL+A) will guarantee all channels are selected.
This also saves time if there is a long list of channels to select.

Copy As — Export a plot to either a file or to the Windows Clipboard.

Delete Data — Remove sections of data from sequential data. The collection of data before and after the removed
section will then be joined together to create a new data channel. This feature may be used to remove
unwanted spikes or noise from data before applying a Histogram-type DataMode analysis. For more
information, see Editing Data - Delete Data.

Interpolate — Replace selected data values within an active plot with a smooth transition line between the last
data point prior to the selected range and the first data point after the selected range. For more
information, see Editing Data - Interpolate.

Poke — Replace either a value or a group of values with another value that is user-defined. For more information,
see Editing Data - Poke.

Scale and Offset — Alter data using a user-defined scale factor and offset factor. For more information, see Editing
Data - Scale and Offset.

Start-Up and Application Window e page 9



Display Menu
Single Plot — Plot one or multiple channels in individual windows.

Cross Plot — Plot one sequential data channel versus another, point for point. The first channel selected plots on
the X-axis, and the second channel plots on the Y-axis. This allows for plots of two channels in direct
comparison, eliminating the time dimension (X-axis) from both channels. At least two data channels must
be selected for Cross Plot to work.

Over Plot — Plot two or more sequential data channels in the same plot graph, one data channel over the other.

Multi Plot — Plot selected sequential channels within the same window, one below the other. In a Multi Plot, the
time base (X value) is the same for every channel selected. When plotting, the plot will begin with the
smallest X value and end with the largest X value. This ensures that every channel selected will be plotted.

Tabular — Plots the selected data in a table format. This provides a method to view the specific value for each
sample in sequential data. Bin counts will be displayed when viewing histogram data.

Metadata — View the information that is tied directly to a particular channel or channels.

Tools Menu

Script Player — Automate various InField procedures. This is useful when there are a number of different analysis
functions that may be required for individual or groups of channels. Rather than running a channel selection,
DataMode, plot procedure, etc. as individual items, a script may be used to combine these functions into
one item that can then be repeated for multiple tests and channels.

Statistics — Evaluate the basic statistics for sequential and histogram channel data and display those statistics in a
text window. The contents of the window can then be copied to applications, such as Excel, using the Copy
As command under the Edit menu.

Signal Calculator — Use mathematical expressions to combine sequential data channels to create virtual data
channels known as computed channels. Most arithmetic, Boolean, trigopnometric, and logarithmic functions
are supported by the Signal Calculator.

DataModes — Open a submenu that contains the various DataModes that can be performed in InField.
Fatigue Damage — Open a submenu that contains the various Fatigue Damage calculating methods

Frequency Analysis — Open a submenu containing commands used to investigate the frequency content of
measured signals, displacements, loads, strains, velocities, acceleration, sound pressure, etc.

Filtering — Open a submenu containing commands for FIR/Butterworth filtering, resampling, and importing filter
characteristics.

Options — Access selections for saving certain aspects of InField when closed.

Password Information — Open a window with the licensing information regarding the installed version of InField.

Window Menu

Cascade — Resize all open windows to the same size and then stack them, starting in the upper left corner of the
work area. Each successive window will be offset down and to the left of the previous window.The amount
of offset will allow the title bar of each window to be shown.
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Tile Horizontally — Resize all of the windows so they are visible and the same size, one above the other.With two
or three windows, they will span the entire width of the InField work area. With four or more windows,
they will be in various columns and rows based on the number of windows and the size of the work area.

Tile Vertically — Resize all of the windows so they are visible and the same size, one beside the other. With two
or three windows, they will span the entire height of the InField work area. With four or more windows,
they will be in various columns and rows based on the number of windows and the size of the work area.

Close All — Close all of the open windows located within InField. The only window that will remain open is the
Channels List window.

Show Channels List — Open the Channels List when not present in the InField work area. It can also be used to
bring the Channels List window to the front when obscured by other windows.

Help Menu

Contents — Display the main contents page of the Help System.The main Help menu is also available from any
screen by selecting F1 from the keyboard.

About SoMat InField — Display the InField version number, copyright data, SoMat's email address, and the URL for
the SoMat website.

InField Toolbars

Application Toolbar

The application toolbar is located in the application window and contains buttons to access the Channels List,
DataModes, and data validation tools. A brief description of these buttons follows:

Show Channels List — Open the Channels List when not present in the InField work area. It can also be
used to bring the Channels List window to the front when obscured by other windows.

i Script Playback — Automate various InField procedures. This is useful when there are a number of
different analysis functions that may be required for individual channels or groups of channels. Rather than
running channel selections, DataModes, plot procedures, etc. as individual items, a script may be used to
combine these functions into one item that can then be repeated for multiple tests and channels.

E Statistics — Evaluate the basic statistics for sequential and histogram channel data and display those
statistics in a text window. The contents of the window can then be copied to applications, such as Excel,
using the Copy As command under the Edit menu.

E Signal Calculator — Use mathematical expressions to combine sequential data channels to create virtual
data channels known as computed channels. Most arithmetic, Boolean, trigonometric, and logarithmic
functions are supported by the Signal Calculator.
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Time History DataMode — Convert a series of time histories into another series of time histories
created by using one of the channels as a data trigger. This allows data to be removed before certain
conditions occur or data to be sampled every time a certain condition occurs.

Burst History DataMode — Convert a series of time histories into a series of burst histories by using
one of the channels as a data trigger. This allows data around certain conditions to be sampled for
predefined periods of time.

Peak Valley DataMode — Convert a series of time histories into a series of successive peaks and valleys.
One of the input channels is selected as a master channel. Whenever there is a peak or valley on the
selected channel, all of the channels are sampled. A trigger channel can be defined, which allows for pre-
filtering the data.

Peak Valley Matrix DataMode — Convert time histories into Peak Valley Matrices. One of the input
channels may be used as a trigger channel if desired.

Rainflow Matrix DataMode — Convert sequential data channels into rainflow matrices that are typically
used in low-cycle fatigue damage analyses. One of the input channels may be used as a trigger channel if
desired. The Rainflow DataMode only accepts sequential data. If the channels have different sample rates,
the triggering options are disabled.

Time-At-Level Matrix DataMode — Convert a series of time histories into a multidimensional time-at-
level matrix. For each input channel, there will be one dimension. For each sample, the algorithm classifies
each input channel amplitude into a bin with its respective dimension. The maximum number of input
channels is six, limiting the output dimensions. Plotting and displaying a large amount of data can be very
laborious for a large matrix (approximately 12MB of data if each dimension was classified into 10 bins). A
data trigger can be defined if required.

Digital Filter Design — Configure and apply a digital filter to selected data.

AutoPower Spectrum Analysis — Investigate the frequency content of measured signals, displacements,
loads, strains, velocities, acceleration, sound pressure, etc.

FFT Analysis — Translate the selected input channel from the time domain, amplitude versus time, to the
frequency domain, amplitude versus frequency.

Inverse FFT Analysis — Translate the selected input channels from the frequency domain, amplitude
versus frequency, to the time domain, amplitude versus time.

Resampling — Change the number of samples taken from an input channel. This may be necessary when
using a DataMode to combine two channels that have been collected using different sample rates.

Frequency Response Analysis —Evaluate the relationship between channels in the frequency domain.
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Rosette Analysis — Convert the three strains from a rosette strain gage (rectangular or delta) into
orthogonal axial strains and/or stresses. These can be further resolved into principal strains, principal
stresses, tensile or shear strains at arbitrary angles,Von Mises stress, etc.

Strain Life — Model actual stress-strain behavior at the critical location in a component. Plastic strains that
may occur infrequently during service loading are accounted for in this analysis. Cycle-dependent material
properties provide a more accurate estimate of the service performance of the material than traditional
tensile test data. Use of the Strain Life method is limited to situations where crack nucleation consumes
the majority of the service life. This is typical of smaller components rather than of full-scale engineering
structures.

Stress Life — Used for long lives where plastic strains can be ignored. The approach assumes that the
nominal stress and fatigue limit of the material control the behavior of the structure. Alternatively, the
relationship between the fatigue life and nominal stress on a complex component such as a weld could be
experimentally determined. Many empirical relationships have been developed during the last 100 years.
Standard weld SN curves such as those from the BS5400 can be used, although InField provides a specific
BS5400 analysis module.

Load Life —Test components under constant amplitude loading in the laboratory to establish baseline data
for their durability. This data is then used to estimate how long a component can be expected to last during
variable amplitude service conditions.

Weld (BS5400) — Analyze the welded areas of structures.

Crack Growth — Use linear elastic fracture mechanics and related crack growth material properties to
determine how fast a crack or crack-like defect will spread under service loading conditions. This analysis
in turn provides an estimate of the remaining safe life of the structure or component.

Channels List Toolbar

The toolbar available from the Channels List is used in the plotting and manipulation of data located in the
Channels List. A brief description of each of the items on the Channels List toolbar follows:

Configure Channels List — Add or remove columns in the Channels List window. Columns include
Filename, Channel Number, Run #, DataMode Type, Directory, Sample Rate, and Channel number.

Help for Channels List — Open the help file associated with the Channels List.

Open Data Files — Open test data files. Currently, InField supports *.SIF,*_RSP,* _DAC, *.CYH, *.ASC,
* _TXT,*_.DAT,*.TH, *.PV,*_MD, *.1D, *.2D, and * _.MAT.

Save As — Save the selected channels in the Channels List to a new data file.
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ﬂ Edit Metadata - Modify the metadata associated with a particular channel or set of channels.

@ Single Plot - Plot a single channel per plot window.

M Cross Plot — Plot one channel versus another, point for point. The first channel selected plots on the X-

axis, and the second channel plots on the Y-axis. This allows for plots of two channels in direct comparison,
eliminating the time element (X-axis) from both channels. At least two channels must be selected as data
for Cross Plot to work.

Over Plot - Plot two or more sequential data channels in the same plot graph, one data channel over the
other.

Multi Plot - Plot selected sequential channels within the same window, one plot below the other. In a Multi
Plot, the time base (X value) is the same for every channel selected. When plotting, the plot will begin with
the smallest X value and end with the largest X value. This ensures that every sample point in the selected
channel(s) will be plotted.

Tabular Display — Plot the selected data in a table format. This provides a method to view the specific
value for each sample in sequential data. Bin counts will be displayed when viewing histogram data. The
names of the source file and channels are located in the title bar.

Preferred Plot — Plot the selected channel according to pre-defined parameters embedded in the channel
by the analysis program that created the channel. For a channel to be plotted using Preferred Plot, it must
contain at least one of the Preferred Plot Keywords. If these keywords are not present, the Preferred Plot
function is identical to the Single Plot function.
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Selecting Data

Channels List
The Channels List window is where data is selected for plotting and analysis. Channels are loaded into the

Channels List using the Open button, % on the Channels List toolbar or by selecting Open from the File menu.

=h[Active] Channels List = =] ﬂ
b akcAr=al= IR e == | [Showal =]

Filename | Chan M ame | Fun # | Datakode Type | Diirectony ﬂ

Allmodes. sif TimeHista, 1 TIMHIS C:4Program FilezS ok athnField“E samples

Allmodes. sif TimeHistB 1 TIMHIS C:4Program FilezS ok athnField“E samples

Allmodes. sif 10 1 TIMHIS C:4Program FilezS ok athnField“E samples

Eracket, zif Strain_b43 1 TIMHIS C:4Program FilezS ok athnField“E samples

Eracket, zif Strain_chE 1 TIMHIS C:4Program FilezS ok athnField“E samples

Dmodes. sif Strain_al 1 TIMHIS C:4Program FilezS ok athnField“E samples

Dmodes. sif Strain_a23 1 TIMHIS C:4Program FilezS ok athnField“E samples

Dmodes. sif Strain_bE 1 TIMHIS C:4Program FilezS ok athnField“E samples

Dmodes. sif Strain_d47 1 TIMHIS C:4Program FilezS ok athnField“E samples

Dmodes. sif Strain_b48 1 TIMHIS C:4Program FilezS ok athnField“E samples

Dmodes. sif Trigger 1 TIMHIS C:4Program FilezS ok athnField“E samples

E=ample. zif Sine we Tri 1 TIMLEY C:4Program FilezS ok athnField“E samples

E=ample. zif tanual Fotor 1 TIMHIS C:4Program FilezS ok athnField“E samples

E=ample. zif Sine 1 TIMHIS C:4Program FilezS ok athnField“E samples

E=ample. zif Triangle 1 TIMHIS C:4Program FilezS ok athnField“E samples L=

FrequencyData..  10WSinedt50 1 TIMHIS C:4Program FilezS ok athnField“E samples

FrequencyData.. BWCoSineAr100 1 TIMHIS C:4Program FilezS ok athnField“E samples

FrequencyData..  Muli-Sine 1 TIMHIS C:4Program FilezS ok athnField“E samples

FunlpsndDow... Timed_Tachl.... 1 TIMHIS C:4Program FilezS ok athnField“E samples

RunlpsndDow...  Time3_Mic2R... 1 TIMHIS C:4Program FilezS ok athnField“E samples

RunlpsndDow...  TimeZ_scceld.... 1 TIMHIS C:4Program Filez5 o athnFieldyE xamples ﬂ
Channels List | Dutput List

InField Channels List

The Channels List, by default, displays the name of the file, the channel name, run number, DataMode type, and
the subdirectory where the file is stored for each open channel.

Accessing the Channels List

The Channels List can be opened using one of the following options:

* Click the Show Channels List button
* From the Window menu, select Show Channels List

* Press F2 on the keyboard
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Channels List Right-Click Menu
Several commands related to the Channels List window are available via a menu that opens with a right-click of
the mouse.

Cpen (Disk File)

Copy (List to Clipboard)

Select all Channels

Remove Channel(s) from Channels List
Remove All Channelis)

Configure
IIpdate Channels Lisk

Edit Selected Channel{s) Metadata. ..

Help

Channels List Right-Click Menu

Open (Disk File) - Open test data files. The window that opens will be a standard Windows File Open dialog.
Locate and open the files that require viewing and analysis. Different file format types can be selected by
using the down arrow to the right of the Files of type box.

Copy (List to Clipboard) - Copy the Channels List to the Windows clipboard for use in other programs.
Select All Channels - Select all of the channels in the Channels List.

Remove Channel(s) from Channels List - Remove selected channels from the Channels List. Highlight the
channel(s) to remove, then right-click and select Remove channel(s) from Channels List.

Remove All Channel(s) - Remove all channels from the Channels List without the need to pre-select the
channels.

Configure - See Channels List Configuration in the next section.

Update Channels List - Place the contents of the Channels List back in the order in which it was developed.
Also turn off any refinements that were made to the channels in the Channels List.

Edit Selected Channels(s) Metadata... - Open the Edit Metadata dialog. Allows a method to edit values
associated with metadata keywords embedded within channel data.

Help - Open the help topic directly related to the Channels List.

Channels List Configuration

Configuration is used to add or remove columns in the Channels List window. Columns include Filename, Channel
Number, Run #, DataMode Type, Directory, and Sample Rate. These columns make it easy to keep track of test
data during the analysis.

To open the Edit Channels List Columns dialog either:

« Click on the Configure button, ﬂ in the Channels List or
* Right-click on the Channels List and select Configure from the menu.
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The titles in the left window are available columns.

The titles in the right window are the active columns in the Channels List and Output List tab of the Channels
List window.

. Edit Channels List Columns %]

Candidatez Selections

Chantum - Filename
ChanType Chan M ame
HistogramT ype Add x> Run #
HumDims — 1 D atabdode Type
[ratabd odet um = Dhirectory
MumPaintz S8 HEMEYE
SampleR ate

Samplelnc

BazeTime g™
MurmBursts

Scale

Offzet w Down v
DataType

SampleBits

Operator

TeztTitle

TestD ate

TestTime ﬂ

Help | ] | Cancel |

Channels List Configuration Window

<< Clear <<

Adding Columns

To add columns, select the name of the column to be added from the list on the left. Click Add.

Removing Columns

To remove a column, select the name of the column to be removed from the list on the right. Click Remove.

Move up/Move down

To rearrange the columns, select the column name in the right window. Use the Up and Down buttons to move
the column within the list (and therefore in the Channels List window.) The alignment of the columns in the
Channels List is associated with the position of the column in the list. Names higher on the list will be positioned
toward the left of the window, and names lower on the list will be toward the right.

Buttons
Help - Open the InField help system to the topic directly related to configuration of the Channels List window.
OK - Record and incorporate changes and exit the window.

Cancel - Exit the window without making any changes to the columns.
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Resizing Columns ﬂ
There are two methods to resize the width of a column:

« Position the mouse pointer over the right edge of the column to resize. Click and drag the column to the
desired width.

« Position the mouse pointer over the right edge of the column to resize. Double-click the edge. This will
automatically resize the width of the column to fit the widest item contained in the column.

Viewing Channels by Criteria |Shewal =l

The Channel Drop-down List Box is used to view the channels in the Channels List according to a variety of
parameters. This makes it much easier to locate channels based on certain criteria. The available options are:

Show All - Show all channels loaded into the Channels List.
Show Only Files - Show only the first channel from each file loaded into the Channels List.
Show Only Files and Runs - Show only the first channel of each run from the files in the Channels List.

Show Selected Runs - Show the channels based on the run. By highlighting a particular run number and
selecting Show Selected Runs, only the run number (i.e. 1, 2, 3, etc.) will be available in the Channels List.

Show Selected Channel Name - Show the channels according to the channel name. This is useful to view a
particular channel when multiple runs are associated with the channel.

Show Selected Mode Type - Show the channels according to the mode. Highlight the channel with the mode
type to view (i.e. TIMHIS, TIMLEV, RANFLW, etc.) and select Show Selected Mode Type. Only the channels
associated with a particular DataMode will be displayed.

Loading Channels
Use one of the following methods to open channels in the Channels List:

* Click the Open button, % from the Channels List toolbar
« Select Open from the File menu
e Press CTRL+O on the keyboard
Each of these methods will open a standard Windows dialog for selecting a file to open.
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NOTE: The first time InField is opened, this dialog will open to the default location, the Examples
directory of the InField installation.

Load Channels List 7] ]
Look, in: | | Examples ﬂ i Rl
=] Bracket, sif [#] ShockData, sif
|#] Drades . sif 2] SomeMades. sif
[#] Exarnple. sif [#] SpacaTruss, sif

[#®] FrequencyData.sif =] Spikes, sif
|=8] RunUpaAndDawn, sif
28] Sae. sif

Fil= narne: |
Files of type: | Sobat Infarmation File [*.51F) | Cancel

Load Channels List Dialog Box

Currently, InField supports *.SIF,* .DAT,*.DAC,*.CYH,,*.ASC,*.TXT,*.RSP,*.TH,*.PV,*_MD, *_1D, *.2D
and *_MAT.

The different file types can be selected by opening the Files of type drop down list with the down arrow to the
right of the text box.

Select the file(s) by either highlighting them in the file list box or typing their name(s) in the File Name box.To
select two or more files, hold down the CTRL key and click each file to open. The Shift key can also be used to
select a group of files. Complete the process by clicking the Open button.

If opening only one file, the process can be simplified into a single step - double-click the filename.

Selecting Data

Data channels must be selected before any of the analysis or plotting functions can be used within InField. The
data set can be one channel or several channels selected from the Channels List.

Knowing how to select a data set is essential to understanding the rest of this manual and how to use the many
functions within InField.

Selecting Channels from the Channels List

Channels highlighted in the Channels List window make up a data set. This data set can be a single channel or a
selection of multiple channels.
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Selecting Channels Using the Mouse

Use the following methods to select channels from the Channels List using the mouse:

Selecting Single Channels

To select a single channel, click on the channel to be selected.

Selecting Multiple Channels
There are two methods to select multiple channels from the Channels List.

1) To select adjoining channels, use the mouse to click and drag from the first channel to the last channel to
select.

2)  To select multiple, individual channels, click on each channel while holding the Control (CTRL) key. Channels
can be removed from a selection using the same method.

Selecting Channels Using the Keyboard

The keyboard can also be used to select channels from the Channels List.

Selecting Single Channels

To select a single channel, use the arrow keys to move the highlight bar to the desired channel.

Selecting Multiple Channels

To select multiple channels, use the arrow keys to highlight the first channel in the group of channels. While
holding the shift key, use the arrow keys to select the group of channels. It should be noted that only adjacent
channels can be selected when using the keyboard.
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Viewing Data

This section introduces the data and text display windows in InField, as well as information on plotting channel
data, configuring plots, and exporting data from InField.

The basis for viewing data is the data selected—the active data set. It is essential to be familiar with the
information in Selecting Data in order to best understand how data is selected for use within InField. Arbitrary
data selection instructions are used for this section. Refer to Selecting Data for more details on selecting data.

Data Windows

There are three basic types of InField data windows: sequential data plot, histogram data plot, and tabular display.
The following images show the three data window types.
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0.03 -0.0117326 -0.0216571 TA7 954 795.395 S02.7 160.065
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0.0566667 -40.0927 -0.0216571 - - - -

0.06 -40.0927 -0.0216571 TA7 954 795.395 G027 157.354

0.0633333 -20.0522 -0.0216571 - - - j

Tabular Data Display

InField data windows have the standard title bar, control buttons, and border of Windows-based applications, and
they can be moved and resized. The title bar displays the names of the source file and channel(s) displayed.

Plotting Data

InField automatically plots sequential and histogram data in the appropriate format. Histograms are plotted on
two axes. If the data for a histogram includes a third axis, InField will prompt the user to select two axes to be

used in the histogram.

Viewing Data « page 22



Plotting One Channel

Single Plot
Use the following procedure to plot a single sequential data channel.

1 Load the channel(s) into the Channels List. For more information regarding loading channels into the
channels list, see Selecting Data - Loading Channels.

If the Channels List window is not open, open it by either selecting Show Channels List from the Window

menu, clicking the Show Channels List button, , or pressing F2.

2. Select the channel(s) to plot in the Channels List. For more information regarding selecting channels see
Selecting Data - Selecting Data from the Channels List.

3. The data can be plotted using any one of the following commands:

* Click the Single Plot button, @ on the Channels List toolbar.
« Select Single Plot from the Display menu
 Double-click the channel in the Channels List

The plot shown is Strain_b48.sif from the example file Dmodes.sif. The file name and channel name are provided
in the title bar of the plot.
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Strain_b48 Single Channel Plot

Once plotted, sections of the data can be zoomed (enlarged), or data points within the plot can be selected with
X,y and n (scan index) or z (bin count) values displayed. Zooming and Viewing data points are covered later in this
section.
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Plotting Multiple Channels

Two or more channels can be plotted at the same time, as long as all of the selected channels are the same type
of data. When the channels are all sequential data, they can either be plotted in separate windows or all together
in one window. Histogram data channels are always plotted in separate windows. The plots are generated in the
same order in which the channels were selected in the Channels List.

There are several options available for plotting multiple channels. These options include a separate graph for each
channel plotted in individual windows, a separate graph for each channel in a single plot window, all plots overlaid
in a single window, and an X vs.Y plot in a single window.

One Plot Per Window

With the one plot per window option, a separate plot window is opened for each of the selected channels.

To use this option, select the channels to be plotted and then either:

« Click the Single Plot button, @ on the Channels List toolbar.
« Select Single Plot from the Display menu.

Multi Plot

The InField Multi Plot option plots selected sequential data channels within the same window, one below the
other.The plot shown is a Multi Plot of Strain_b43 and Strain b_56 from the example file Bracket.sif.
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Multi Plot Window

In a Multi Plot, the time base (X-axis) is the same for each plot. InField starts with the smallest X value from the
channels selected and ends with the largest X value from the channels selected. This allows each channel to be
fully plotted.

To use the Multi Plot option, select the channels to be plotted and then either:
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¢ Click the Multi Plot button, =l on the Channels List toolbar.
* Select Multi Plot from the Display menu.

The maximum number of plots visible in a Multi Plot window can be set in the InField Options dialog accessible
from the the Tools Menu. Available options for the number of plots are located in the Max. SubPlots in MultiPlot

drop-down box.
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InField Options Display

Over Plot

The InField Over Plot function plots two or more sequential data channels in the same plot graph, one data plot

overlaid on the other.
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When plotting data using the Over Plot function, the X-axis range will start at the smallest value for the data
selected. The greatest X value of the data will determine the upper limit of the X-axis for the data plot. This
method allows all of the data to be displayed in the Over Plot window.

To use this option, select the channels to be plotted, and either:

« Click the Over Plot button, % on the Channels List toolbar.
* Select Over Plot from the Display menu.

Cross Plot

The InField Cross Plot function plots one channel versus another, point for point. The first channel plots on the
X axis, the second on theY axis.
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Cross Plot Window

Plotting of an X vs.Y plot ends when all of the points in the channel with the least number of points have been
plotted. This ability to plot one channel versus another is possible by eliminating the time dimension (X axis) from
both channels.

To use this option, select the channels to be plotted and either:

¢ Click the Cross Plot button, M on the Channels List toolbar.
« Select Cross Plot from the Display menu.

Viewing Data ¢ page 26



Zoom

The InField Zoom function provides a method to enlarge a section of the data in a sequential data plot. The
selected data is plotted in the same window, and the original plot window is obscured until the data is unzoomed.
Zooming in on data can be done repeatedly until the necessary details are shown.

Selecting a Range of Values

When selecting a range of values to enlarge, either a set of X values or a set of X and Y values can be selected.
The following figures show both selection methods.

With the range of X values selection method, only the data along the X axis is selected. All Y values will be
included in the data selection.With the range of X andY values, data is selected both vertically and horizontally.
With both methods, the selected X values set the number of points on the X axis in the plot window.
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Range of X Values

The following procedure describes how to select a range of X values.

1. Place the crosshair pointer at the starting point for the range of data to be enlarged.
2. Press and hold down the left mouse button.

3. Drag the edge of the highlight area until the desired range is highlighted. Release the button once the data
has been highlighted.

Steps 2 and 3 of the above procedure are commonly referred to as “click and drag.”
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Range of X andY Values

Selecting a range of X and Y values is the same as selecting a range of X values, except in this case the shift key
is held down while selecting the values.

1 Place the crosshair pointer at the starting point for the X andY values to be enlarged.
2. Press and hold down one of the Shift keys, then click and hold down the left mouse button.

3. Drag the edge of the highlight area until all the X andY values are highlighted. Release the button once the
data has been highlighted.

Zooming

Once a selection of data has been highlighted, a down arrow ﬂ will appear in the plot window toolbar. Clicking
on this button will activate the Zoom function.

Scrolling Data

Once data has been selected and enlarged, the following items will be available to navigate through the data values.

ﬂ Unzoom - Clicking the Unzoom button will exit the current zoomed selection of data and return to the
previous data.

ﬂ Scroll Left - The Scroll Left button will move the cursor left within the data window, toward data of a
previous time.The cursor can also be moved by using the left arrow key on the keyboard.

ﬂ Scroll Right - The Scroll Right button will move the cursor right within the data window, toward data of a
greater time.The cursor can also be moved by using the right arrow key on the keyboard.

Export Plot

Export Plot is used to export the plot to either a file or to the Windows Clipboard. Selecting this function will
open a dialog with the following available options:

Export Format
There are three different export formats available in InField.

Enhanced Metafile - Save the plot as an Enhanced Metafile. This option allows saving the plot directly to
the Windows Clipboard or as a new file.

Windows Bitmap - Save the plot as a Windows Bitmap. This option allows saving the plot directly to the
Windows Clipboard or as a new file.

InField Plot Script - Save the plot as an Enhanced Metafile. This option only allows saving the plot as a
new file. This new file will only be compatible for use with InField.

Size - A method to control the image size for export.This can be useful when the file may be used within other
applications.
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Buttons

Export to File - Save the plot image to a file format. Formats are listed under Export Format.
Copy to Clipboard - Save the plot image to the Windows Clipboard.

Cancel - Exit the Export Plot window without performing any functions.

Help - Open the InField help system to the topic directly related to Export Plot.

Viewing Data Points

The x and y values for a data point (sample) in a data plot can be displayed in the plot window. For all plots except
Cross Plots, a third value is also displayed. For sequential data, this third value is labeled n and indicates the sample
index. For histogram data, this third value is labeled z and indicates the bin count.

Selecting a Data Point

Move the pointer to the desired point (or area) within the plot. Click to place the crosshair on the plot. The
intersection of the two lines indicates the selected data point.

Once the crosshair has been placed within the plot, the following methods can be used to select a new data point
for viewing:
 Use the right and left arrow buttons in the display window to move the location of the data point along
the X axis of the graph.

 Use the right and left keys on the computer keyboard to move the location of the data point along the
X axis of the graph.

« For histogram plots, use the up and down arrow keys on the computer keyboard to move the location of
the data point along the Y axis of the graph.

* The mouse can be used to click on the new data point

Cursor Movement Using the Keyboard

When using the keyboard or the buttons in the display window, the cursor will move along the X axis in
increments equivalent to the sample rate.

Different keystroke combinations provide for incremental navigation of data points along the X-axis.

« Holding down the SHIFT key while pressing the arrow keys will move the cursor in current sample index
+ 10 increments.

e Holding down the CTRL key while pressing the arrow keys will move the cursor in current sample index
+ 100 increments.

e Holding down the SHIFT and CTRL keys while pressing the arrow keys will move the cursor in current
sample index + 1000 increments.
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Viewing Data Points in a Single Plot
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Viewing a Data Point - Single Plot Window

In a Single Plot window the x, y, and n values of the selected data point will be displayed along the upper edge of
the graph.

Viewing Data Points in a Multi Plot
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Viewing a Data Point - Multi Plot Window

In a Multi Plot window the x,y, and n values of the selected data point will be displayed along the upper edge of
each graph.
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Viewing Data Points in an Over Plot
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Viewing a Data Point - Over Plot Window

In an Over Plot window the x,y, and n values of the selected data points will be color coded to coordinate to the
plot data and displayed along the upper edge of the graph.

Viewing Data Points in a Cross Plot
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Viewing a Data Point - Cross Plot Window

In a Cross Plot window the x and y values of the selected data point will be displayed along the upper edge of the
graph.

Viewing Data * page 31



Viewing Data Points in a Histogram Plot

i:l:][nctive] Allmodes.sif-2d_HistB

=10l
¥(2/@] |1 [fso] £]e]-]

Allmodes.sif - 2d Histh
x:-154.375 ¥: 96.875 z: 39

500 —

....

To [uE)

500 - EEENEEETT T

-1000—

I I I T
-1000 -500 1] 500

From [uE)

Viewing a Data Point - Histogram Plot

In a Histogram plot the x,y, and z values of the selected data point will be displayed along the upper edge of the
graph.
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Tabular Data Display

The Tabular Display command plots the selected data in a table format. This provides a method to view the specific
value of each sample in sequential data or the bin counts in histogram data.

To use this option, select the channel(s) to be plotted then:

e Click the Tabular button, : , on the Channels List toolbar.

» Select Tabular from the Display menu.

=N Bracket.sif-Strain_b43 Bracket.sif-Str - Ol x|
Strain_b4d3 Strain_c5h6 Strain_al Strain_a23  [Strain_bE | Strain_d47 il

Time Strain Gage Strain Gage Strain Strain Strain Strain

Seconds ustrain ustrain LE LE LE LE

0 9992 00216571 797.954 795398 319.951 160318

000333333 2002585 -0.0216571 - - - .

0.00EGEEEY 2002832 -0.0216571 - - - --

0.1 9.99212 00216571 797.954 795,395 30T 16068

0.01 33333 999212 9.007ES -- -- -- --

0.01 BEGET -0.0117326 900765 - - - .

0.02 -0.0117326 -0.0216571 Ta7 954 795398 301 569 16063

00233333 -10.0156 -0.0216571 - - - -

00266667 -10.0156 -0.021 6571 -- -- -- --

0.03 -0.0117326 -0.0216571 TA7 954 785,395 283138 160.063

00333333 -0.0117326 -0.0216571 -- -- -- --

00566667 -0.0117326 -0.0216571 - - - -

0.04 -0.0117326 -0.021 6571 T97.954 795395 255523 159144

0.0433333 -10.01356 -0.0216571 - - - --

00466667 -10.0156 -0.0216571 -- -- -- -- j
. Example sif-Sine vs Tri P ] 1
Triangle(Units) \ Sine(Units) underflow [-225 175 |-125 [-075 |-025 |025 o075 [1.25 |175 225 |overtiow
uncler flow a Hu a 0 0 a 0 1] 0 1] 0 1]

-2.25 1] 0 1] 0 0 1] 0 1] 0 1] 0 1]
-1.75 1] 0 1] 0 19 ar 41 20 0 1] 0 1]
-1.25 1] 0 1] 38 18 1] 0 20 40 1] 0 1]
-0.75 1] 0 a7 0 0 1] 0 1] 0 1] 0 1]
-0.25 1] 0 a7 0 0 1] 0 1] 0 =10 0 1]
0.25 1] 0 a7 0 0 1] 0 1] 0 =10 0 1]
075 1] 0 ar 0 0 1] 0 1] 0 50 0 1]
1.25 1] 0 1] 38 18 1] 0 20 40 1] 0 1]
1.75 1] 0 1] 0 19 35 g0 20 0 1] 0 1]
225 1] 0 1] 0 0 1] 0 1] 0 1] 0 1]
averflow 1] 0 1] 0 0 1] 0 1] 0 1] 0 1]

Tabular Data Display - Histogram Data
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The names of the source file and channels are located in the title bar. For sequential data the left column lists the
times at which the samples were taken, and the other columns show the sample value for each channel at the
corresponding time. For histogram data the left column reflects the data selection for the Y-axis, and the other
columns reflect the data selection for the X-axis. The data displayed within the table reflects bin counts, including
the underflow and overflow bins.

Viewing Metadata

Viewing Metadata provides a method of viewing the information that is tied directly to a particular channel or
channels.

To use this option, select the channel(s) to view, and then select Metadata from the Display menu.

=8 Channel Metadata =10] =]
FileMame Dmodes . =sif : Dmodes . sif Dmodes. =if Example.=if Example.sif Example.sif il
Chankame Strain_dd47 Strain_b4g Trigger Sime ws Tri Manual Rotor Sire

Chankum 4 5 <] 1 2 3

ChanType SEQUEMTIAL SEQUEMTIAL SEQUENTIAL HISTOGRAM SEQUENTIAL SEQUENTIAL

Runfum 1 1 1 1 1 1

DatahodeType TIRHIZ TIRHIZ TIRHIZ TIRALE™ TIRHIZ TIkHIZ

HistogramType [FEN [FE [FE TAL P, i,

HumbDims 2 2 2 3 2 2

DratahodeiMum 1 1 1 1 2 2

MumPoirts: 10001 10001 10001 10 =l =1 =g =1

SampleRate 100 100 100 2 100 100

Samplelinc oo oo oo s oo om

BaseTime L] L] L] -2.5 a a

MumBursts o o o a a a

Scale 00124544 00173229 0006375 1 000741847 89978171687 45362e-005
Orifset -220.594 -265.518 -63.75 a -11.0435 -3.00379

DataType UIMT_16BIT UIMT_16BIT UIMT_16BIT FLOAT_S2BIT UIMT_16BIT UIMT_16BIT

SampleBits e, M, M, A, Mra, A,

Cperator Rlra, Rlra, Rlra, Plrs, Plra, Plrs,

TestTitle hlra, Ilrs, Ilrs, Plrs, s, P,

TestDate [FEN [FE [FE 1994-03-27 1994-03-27 1994-03-27

TestTime (SR (SR (SR 1921:09:55.000 1921:09:55.000 1921:09:55.000
PhysicalChantum e, M, M, P, P, P,

FileType EASE::Data Sif EASE::Datar: Sif EASE::Data Sif EASE::Data Sif EASE::Data Sif EASE:Data: Sif

FileDate 1999-02-22 1999-02-22 1999-02-22 1999-03-16 1999-03-16 1999-03-16

FileTime 15:10:45.000 15:10:45.000 151 0:45.000 09:50:52.000 09:50:52.000 09:50:52.000

FileSize 130865 130865 130865 10931 10931 108931

MumChans =] =] =] 4 4 4

Axislabel Dim O Time Time Time Sine Time Time

Axislnits Dim O = = o= Unit= Fecs FecE

hiaxalue Dim O 100 100 100 3 aTFs arFs

MaxScan Dim O 10000 10000 10000 (BRI ars ars

hin*alue Ditm O o o o -3 a a

hMin=can Dim 0O o o o Plrs, o o

e o s nain nain mien nin niin I~ |

Metadata Display
Information common to all data channels:
File Name - The name of the data file or test run.
ChanName - The name of the channel selected.
ChanNum - The location of the channel within a particular data run.
ChanType - The type of data stored in the channel.

RunNum - The run in which the channel is located. This is useful when analyzing data from multiple runs within
a group of test runs.

DataMode Type - The DataMode that was used to collect the data.

Histogram Type - The type of histogram associated with the selected channel(s). This is used when analyzing or
plotting the channel.

NumbDims - The number of dimensions that will be used when plotting the selected channel.
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DataModeNum - The number of the DataMode associated with the channel. This humber represents the
placement of the DataMode in relationship to the other DataModes in a particular test run.

NumPoints - The number of sample points contained in the selected channel.

SampleRate - The sample rate for a selected channel.

Samplelnc - The time increment for the sample. It is equal to 1/sample rate

BaseTime - The time of the first data point in a channel. It is usually zero if the data came from a test system.

Run Time - The total time that the data acquisition hardware was collecting data on this channel. It is used by
all fatigue analyses for calculating hours to failure.

Acq Time - The total time that data samples were actually being recorded by the data acquisiton hardware. It is
always derived from the number of points and the sample rate: AcqTime = NumPoints/SampleRate. It is
used by all fatigue analyses for calculating hours to failure.

NumBursts - The number of bursts in a Burst History.The value will be zero if the channel is not a Burst History.
Scale - Factor by which to multiply (or scale) data prior to plotting.
Offset - Factor to add to (or offset) data prior to plotting.
DataType - Precision with which the data is recorded.
SampleBits - The number of bits at which the data was sampled; the resolution of the data.
Operator - The operator (person) associated with a test setup procedure for a particular data collection device.
TestTitle - The title of the test as entered during the test setup procedure for a particular data collection device.
TestDate - The date the test was run.
TestTime - The time the test was run.
PhysicalChannelNum - The hardware channel number from which the data was collected.
FileType - The type of file in which the data is stored (i.e. SoMat Information File is *.SIF.)
FileDate - Creation date of file containing channel data.
FileTime - Creation time of file containing channel data.
FileSize - Size in bytes of file containing channel data.
NumChans - The number of channels within the open Channels List.
Each dimension of the selected data will have the following set of information associated with it:
AxisLabel - The label that will be used for the plot axis reflecting that dimension of data.
AxisUnits - The units that will be used for the plot axis reflecting that dimension of data.
MaxValue - The maximum value for a data sample in that dimension.
MaxScan - The index of the maximum value for a data sample in that dimension.
MinValue - The minimum value for a data sample in that dimension.
MinScan - The index of the minimum value for a data sample in that dimension.

UserMax - The maximum limit of the dynamic range of the channel.
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UserMin - The minimum limit of the dynamic range of the channel.
NumBins - The number of bins for histogram data.

Additional information may be displayed that is specific to particular channels.

Arranging Windows

The plot windows in InField can be manipulated, moved, sized, and closed either as a group using items in the
Window menu or individually using the mouse.

As a Group

Tile Vertically

Tile Vertically resizes all of the plot windows so they are visible and the same size, one beside the other.With
two or three windows, they will span the entire height of the InField work area.With four or more windows,
they will be in various columns and rows based on the number of windows and the size of the work area.

Tile Horizontally

Tile Horizontally resizes all of the plot windows so they are visible and the same size, one above the other.
With two or three windows, they will span the entire width of the InField work area. With four or more
windows, they will be in various columns and rows based on the number of windows and the size of the
work area.

Cascade

Cascade resizes all open plot windows to the same size and then stacks them, starting in the upper left
corner of the work area. Each successive window will be offset down and to the left of the previous window.
The amount of offset will allow the title bar of each window to be shown.

Indivdually

Moving Windows

To move a window, position the cursor on the title bar and then click-and-drag the window to its new
location within the InField work area.

Minimize Windows

To minimize a window (reduce it to a title bar icon), use the the following:

« Click the Minimize button =1 in the title bar.
* Click on the icon at the left end of the title bar and select Minimize from the window control menu.
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Maximize Windows

To maximize a window (make it fill the entire InField work area), use the the following:

« Click the Maximize button 3! in the title bar.
» Click on the icon at the left end of the title bar and select Maximize from the window control menu.

Restoring Windows

To restore a window (return it to its original size), use the the following:

« Click the Restore button & in the title bar.
* Click on the icon at the left end of the title bar and select Restore from the window control menu.

Changing Window Sizes
The size of each individual window can be changed in several ways:

 Adjust the window borders or a corner using the click-and-drag method.
» Use the Cascade or Tile commands from the Window menu.
e Use the minimize, maximize and restore functions.

Closing Windows

Use the following to close only the active window:

« Click the Window Close button, Xl in the title bar.

e Double-click on the icon at the left end of the title bar.

« Click once on the icon at the left end of the title bar and select Close from the window control menu.
To close (remove) all of the windows in the work area, select Close All from the Window menu.

Printing

Using the Print command provides a method to print out the data within a data display window.

Use the following procedure to print data.

1. Make the window to print active.

2. Select Print from the File menu, or press CTRL+P.

3. Click the Page Setup button to change the selected printer, page layout, and paper size and source.
4.  Click OK to send the information to the selected printer.

The only window in InField that cannot be printed using this method is the Channels List.

To print the information from the Channels List, select the channels, or press CTRL+A to select all the channels.
Select Copy As from the Edit menu. This will open the InField Copy As dialog box. Select As Metadata, and then
click Copy. This will place the information on the Windows Clipboard, where it can be pasted into other programs
such as Excel. This will also provide information regarding the channels such as file name, directory, channel
number, channel name, channel type, run number, etc. For more information, see Viewing Metadata covered
previously in this section.
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Editing Data

This section covers the editing of plotted data and text variables within the plotted data.

Plot Configuration

Use the configuration button, ﬂ in any plot window to open the Plot Configuration dialog.

Ed

i, Plot2
Scale Axes To: Plat Fant
{+ Data's Max and Min Save as Default | Fort Mamne : Courier Mew Save s Default |
i~ Test System Limits Apply Mow | Font Size: 10 Edi... |
Channel Mame | Min | Ma:-:| Label | Divs| DF'| Drraw Style Transformation | Title
#=| Time 0 10 Time(zecs) B 1] Linear [
7| Sine 25 2 SinelUnitz) 9 0 Lines Only Linear Example.zif - Sine

Help | Ok Cancel Apply

Plot Configuration Dialog Box
When selected, Plot Configuration allows for a method to change the following items:

Scale Axes To

Data’s Max and Min - Automatically scale the window to the maximum and minimum of the limits of the

data.

Test System Limits - Plot the data to the Y-axis limits specified by the data acquisition system that
collected the data. In this mode, the Y-axis limits of the plot should be equal to fullscalemin and

fullscalemax.

Save as Default - Apply the changes made to either the Data’s Max and Min and/or the Test System Limits

selections and apply these changes to all future plots.
Apply Now - Apply the changes made in the Scale Axes To dialog box.
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Plot Font

Save as Default - Save any changes to the fonts and apply the current font selections to all future plot
windows.

Edit Font - Change the font for Title, Label, and Divisions. Use of this button will open a Windows dialog
enabling selection of a different font, font style, size, script, color and effects. The fonts available will
be those already installed on the computer.

« Some fonts will not work, and InField will default to Courier New.An example is Webdings, where the
character representations are not compatible with InField.

« It is suggested to use fonts that would normally be installed from a standard Windows install. Using
fonts that are not normally part of the Windows operating system may cause problems if files are
transferred to computers where these fonts may not exist.

Spreadsheet Information
The following items listed in the spreadsheet can be changed by double-clicking on the item:

Min - The minimum, or lowest point, of the data. It might be necessary to change this value to show more detail
regarding the data.

Max - The maximum, or highest point, of the data. It might be necessary to change this value to show more detail
regarding the data.

Label - The title located to the left of the graph.The label can be changed to help distinguish the data. It may also
be necessary to change the label if the data will be used for a report, where changing the name will help
clarify the type of data.

Divs - The number of horizontal lines (axis divisions) in the graph. Each line will be labeled to indicate the value
represented. It may be necessary to change this item to help distinguish the Y-value of data at a certain point
on the graph.

DP - The number of decimal points available for data precision. As an example, if DP is set to 2, then the values
will have two decimal positions (x.xx). If DP were set to 3, then the values would have three decimal
positions (X.XXXx).

Draw Style - The type of the plot. The default is Lines Only. A drop-down list of styles will be made available
when the style type is selected by mouse click. Options available are:

Lines Only - Plot a continuous line connecting data points without differentiating between individual data
points and the interval between them.

Points Only - Plot each individual data point.
Lines + Points - Plot each individual data point and a continuous line connecting them.

Bars - Plot a solid line extending from the X-axis to the continuous line connecting the data points. This
option results in a graph "filled" from the X-axis to the data line.
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Transformation - Change how the graph is represented along the time, or X, axis.
Linear - Display the time scale in a standard linear form.

Log - Change the X-axis of the graph to a logarithmic scale. This may be necessary to display data that may
have been taken over a long period of time.

Title - The title, or header, of the graph

Buttons
Help - Open the InField help system to the topic directly related to Plot Configuration.
OK - Apply the changes to the open plot window and close the configuration dialog.

Cancel - Exit the dialog box discarding any changes. Changes made and applied with the Apply button will be
reversed by selecting Cancel.

Apply - Apply changes to the open plot window.

ﬁ Delete Data

Delete Data is used to remove sections of data from sequential data. The collection of data before and after the
removed section will be joined together to create a new data plot.

This feature may be used to remove unwanted spikes or noise from data before applying a histogram-type
DataMode analysis.

Click-and-drag within the plot to select the section of data to be deleted. Select Delete Data from the Edit menu

or click the Delete Data button, ﬂ on the plot window toolbar. A new window will be generated to contain a
plot which reflects the modified data set.

1] Interpolate

Interpolate is used to replace selected data values within an active plot with a smooth transition line between the
last data point prior to the selected range and the first data point after the selected range.

Click-and-drag within the plot to select the section of data to Interpolate. Select Interpolate from the Edit menu

or click the Interpolate button, ﬂ on the plot window toolbar. A new window will be generated to contain a
plot which reflects the modified data set.
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| poke

Poke is used to replace a value, or group of values, with another value that is user-defined.

Click-and-drag within the plot to select the section of data to Poke. Select Poke from the Edit menu or click the
Poke button, E on the plot window toolbar. A menu will open prompting for the value to use as the

replacement value. Once the Value to replace has been provided and OK selected, a new window will be
generated to contain a plot which reflects the modified data set.

X
Walue ko replace -
lﬂi Cancel
Help

Poke Dialog Box

Buttons

OK - Close the dialog box and open a new plot window reflecting the changes to the data.
Cancel - Close the dialog box.

Help - Open the InField help system to the topic directly related to Poke.

ﬂ Scale and Offset

Scale and Offset allows for alteration of data by a user-defined scale factor and offset factor.
Click-and-drag within the plot to select the section of data to Scale and Offset. Select Scale and Offset from the
Edit menu or click the Scale and Offset button, E, on the plot window toolbar. A menu will open prompting for

the values to use as the Scale and Offset. Once the values have been provided and OK selected, a new window
will be generated to contain a plot which reflects the modified data set.

wm,. Scale and Offset Data ﬂ
]
Scale 1
Offset Iiﬂ Cancel
Help

Scale and Offset Dialog Box
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Buttons

OK - Close the Scale and Offset dialog box and open a new plot window reflecting the change(s) made to the
data.

Cancel - Exit without making any changes.

Help - Open the InField help system to the topic directly related to Scale and Offset.

Edit Metadata
Edit Metadata is used to modify the metadata associated with a particular channel or set of channels of data.

The Edit Metadata dialog can be opened by clicking the Metadata button, m on the Channels List toolbar or
by selecting Edit Selected Channel(s) Metadata from the right-click menu in the Channels List.

w, Edit Metadata : =1O] =|

Chant ame

| Tensor Open MultiLine 'window |

Wt Chart ame
O Buntum
[ PhysicalChantum
O BaseTime 1]
O 5ampleRiate 300
O Operatar

O TestTitle

[ awigUriits Dim 0 Secs
[ AwxisLabel Dirm 0 Time
O Usertin Dim 0 1]

[ Usertdax Dim 0 1] -
4| | »
Help Add Eeyward ] | Cancel | Apply |

Edit Metadata Dialog Box

Editing Modes

The default editing mode allows for modification of keyword values as a single line.The highlighted keyword-value
pair in the lower section of the window is reflected in the upper section of the window with the keyword as the
textbox title and the value as the text in the textbox.

When the value contains more than a single line of information, it may be necessary to view and edit it as multiple

lines. This is accomplished by entering MultiLine edit mode via the _ZPenMultiLine indow | button. When in
MultiLine edit mode, the lower section of the dialog expands to allow viewing of multiple lines, simplifying the
editing process for larger values.
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Once changes are complete, use the 1752 Multiine tindow

where all keyword-value pairs are visible.

button to return to the SingleLine editing mode

Note that when editing multiple channels at once, there are fewer items available for modification than when
editing a single channel.

Saving changes to Metadata

When viewing metadata in SingleLine editing mode, keyword-value pairs containing changes that should be saved
for the current session of InField must be marked with a check in the checkbox for that line of metadata. Any
changes not marked by a checkmark will not be saved.

To discard changes and restore the channel(s) back to their original state, select Update Channels List from the
right-click menu in the Channels List.

Saving modified channels for use in future sessions of InField

Changes made in the Edit Metadata dialog are made only within the current session of InField. To permanently
preserve changes to a file, select the channels and use the Save As item in the Tools menu.

Buttons
Help - Open the InField help system to the topic directly related to the Edit Metadata function.

Add Keyword- Add a keyword-value pair to the metadata of the selected channel. There is no requirement that
keyword names begin with 'DM_', 'DK_, etc.

OK - Save the information entered to the metadata associated with the selected channel for the duration of the
current session of InField.

Cancel - Exit without making any changes.Any changes made and applied using the Apply button will be reversed.

Apply - Apply changes to associated metadata without closing the Edit Metadata dialog box.
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Saving Data Files

Saving an Active Data Set to a File

Saving data to a different file format is performed using the Save As command in the File menu.

To save an active data set to a file, select Save As from the File menu.The SaveAs Data File dialog will open. This
dialog is a standard Windows file save dialog.

Savehs Data File

2l

Save in: 1 — OutputFiles

:_] L ] Ei( 'v

o8] AutoPower_000.sif
=] AutoPower_001.sif
o8] AutoPower_002.sif
=] AutoPower_003 . sif
38 BurstHistary_000.sif
=] BurstHistary_001.sif
] BurstHistary_002.sif
=] Caleulatar_000.sif
o8] Calculater_001.sif
=] dAdrPlat_000, sif
=] eMPlat_0o0, sif

=] eMPlot_001 sif
=] eMPlot_00z . sif
=] FFT_000, sif
|8 FFT_001.sif
] FFT_002, sif
=] FFT_003. sif
] FFT_004, sif
] FFT_00S, 5if
o8] Filker_000.sif
=] FRF_000. sif
& FRF_001.sif

=] FRF_002.sif
8] FRF_003.5iF
=] FRF_004.sif
8] FRF_005.siF
=] FRF_006.sif
=] FRF_007.siF
] FRF_008.sif
=] FRF_009,5if
@] FRF_010.sif
| FRF_011.sif
| FRF_012.5if

File: mame: i

Save as type:

iSDMat Infarmation File [ 51F)

i
:J Save 1
:J Cancel i

A

SaveAs Data File Dialog Box

Available File Formats

The file formats available in the Save as type drop-down list correspond to the data file translators present
within InField. The default file format will be *_SIF, which is the standard SoMat Information File format. Other
available file types and their extensions are:

SoMat Information File *
nCode DAC *
ASCII *
MTS RPC Il *
Matlab *

_SIF
-DAC, *_.CYH
ASC, *_.TXT
-RSP
-MAT

Selecting Data to be Saved

If multiple channels have been loaded into the channels list, data can be saved as a single channel to a file or as a
group of channels to a file. Multiple channels can be selected by using SHIFT and the arrow keys on the keyboard
(adjacent channels only), CTRL+mouse-click, or select all channels in the Channels List using CTRL+A.

GPS Microsoft Streets & Trips 2003
GPS Delorme Street Atlas 2003
Entire Channels List

Current Workspace

JTXT
JTXT
-CHL
-WRK
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Validation Tools

InField has a powerful set of data validation tools to assess the performance and durability of mechanical systems
and materials. This section provides an introduction to these tools and assists in selecting the correct tool for
data validation needs.

General Information

Script Player

Script playback allows for a method to automate various InField procedures. This is useful when there are a
number of different analysis functions that may be required for individual or groups of channels. Rather than
running a channel selection, DataMode, plot procedure, etc. as individual items, a script may be used to combine
these functions into one item that can be repeated for multiple tests and channels.

For more information see Script Player.

Statistics

The Statistics tool extracts industry standard information from a list of selected sequential or histogram data
channels. That information contains basic parameters such as maximum, minimum, mean, and standard deviation,
as well as advanced signal statistics such as crest factor, irregularity factor, kurtosis, etc.

For more information see Statistics.

Signal Calculator

The Signal Calculator can be used to create virtual data channels by mathematically combining data channels that
have the same sample rate. Most arithmetic, Boolean, trigonometric, and logarithmic functions are supported.The
created channels may also be referred to as computed channels.

For more information see Signal Calculator.

DataModes
Use one of the DataModes to reduce data channels into more concise data sets that better indicate:
e How mechanical systems are used and perform
« Distribution of extreme inputs
* Ability to repeat load history
e Mechanical system durability
The reduced data sets can be histograms or more concise sequential channels.

Validation Tools « page 45



@ Time History
A Time History is a sequence of constantly sampled data channel values continuously stored in a data file.

This DataMode converts time history data channels into a shorter time history by using one of the input channels
as a data trigger. The data trigger channel (a computed channel) must be created using the Signal Calculator before
the Time History DataMode is run. This triggering allows removal of data before specific conditions occur or
sampling of data each time a specific condition occurs.

The Time History DataMode accepts only time history data. The channels selected must all have the same sample
rate.

For more information see DataModes - Time History.

ﬂ Burst History
A Burst History is a series of fixed-length time histories that are triggered by a user-defined event.

This DataMode converts a series of time histories into a series of burst histories by using one of the input
channels as a data trigger. The data trigger channel (a computed channel) must have been previously created using
the Signal Calculator. This triggering allows removal of data before specific conditions occur or sampling of data
every time a specific condition occurs.

The Burst History DataMode only accepts time history data.

The Burst History DataMode is used primarily to examine high speed, rare events, that may affect both product
performance and reliability, without the overhead of continuously storing all channels.

For more information see DataModes - Burst History.

ﬂ Peak Valley

Peaks and valleys are data values where signals change direction. A Peak Valley history is a collection of successive
peaks and valleys in the data. Data between these signal reversal points (peaks and valleys) is not stored. In order
to be recorded, the span between successive peaks and valleys must exceed a user specified hysteresis value. A
trigger channel can also be specified, providing a method to pre-filter the data.

The Peak Valley DataMode accepts sequential data. It is used primarily as an input to product durability analysis
and to determine extreme loading on a mechanical system.

For more information see DataModes - Peak Valley.

H Peak Valley Matrix

Peaks and valleys are data values where signals change direction. A Peak Valley Matrix is created by categorizing
successive peak-valley pairs and representing their frequency of occurrence in a fixed sized matrix.

The Peak Valley Matrix DataMode converts a series of sequential histories into a series of peak-valley matrices.
One of the input channels can be used as a trigger channel, if desired.

Peak Valley Matrix accepts only sequential data. If the channels selected for the DataMode have different sample
rates, the triggering options will be disabled.
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The Peak Valley DataMode is used primarily for load history characterization and product usage. For example. a
Peak Valley Matrix of gear positions stored in the To-From mode summarizes all of the gear changes made by a
driver over a period of time.

For more information see DataModes - Peak Valley Matrix.

#%| Rainflow

Rainflow counting identifies specific peak valley pairs that contribute to fatigue damage. A rainflow matrix is
created by categorizing rainflow peak-valley pairs and representing their frequency of occurrence in a matrix that
is fixed in size.

The Rainflow DataMode converts a series of sequential data channels into a series of rainflow matrices. These
matrices are typically used in low-cycle fatigue damage analysis. One of the input channels can be used as a trigger
channel if required.

The algorithm used is based on the “one-pass” algorithm described in the paper “Simple Rainflow Counting
Algorithms” by S. Downing and D. Socie published in International Journal of Fatigue, January 1982. The algorithm
generates a set of closed cycles for the input peak-valley sequence, assuming the sequence repeats itself.

The Rainflow DataMode accepts only sequential data. If the selected channels have different sample rates, the
triggering options will be disabled.

The Rainflow DataMode is used for assessing product durability and as a metric for characterizing load histories.

For more information see DataModes - Rainflow.

ﬂ Time-At-Level

A Time-At-Level matrix is formed by categorizing constantly sampled data channels and representing their
frequency of occurrence in a matrix that is fixed in size. Each input channel occupies one dimension of the matrix.
This results in a single data object that contains the amount of time spent at unique combinations of variables.

The Time-At-Level DataMode converts a series of time histories into a multidimensional time-at-level matrix. The
maximum number of input channels, and therefore the number of output dimensions, is six (6).

The Time-At-Level DataMode accepts sequential data. All the input channels must have the same sample rate.

The Time-At-Level DataMode is primarily used for evaluating product performance and usage. For example, a
three dimensional Time-At-Level matrix of torque vs. engine RPM vs. gearshift position is useful for determining
how a vehicle’s engine is used by customers.

For more information see DataModes - Time-At-Level.

Fatigue Damage Calculator

The fatigue analysis functions can be used to estimate component life, crack growth, and weld life under certain
fatigue conditions. Three (3) different methodologies are available to calculate component life: Stress Life, Strain
Life, and Load Life. Available in conjunction with these functions is the Material Property Editor which allows for
creation of InField Material Files (*.MAT) for use with the Strain Life and Crack Growth fatigue analysis functions.
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ﬂ Strain Life Fatigue Analysis

Strain Life analysis models actual stress-strain behavior at the critical location in a component. Plastic strains that
may occur infrequently during service loading are accounted for in this analysis. Cycle-dependent material
properties provide a more accurate estimate of the service performance of the material than traditional tensile
test data. Use of the Strain Life method is limited to situations where crack nucleation consumes the majority of
the service life. This is typical of smaller components rather than of full-scale engineering structures.

For more information see Fatigue Calculator - Strain Life Fatigue Analysis.

ﬂ Stress Life Fatigue Analysis

Stress Life analysis is often used for long lives where plastic strains can be ignored. The approach assumes that
the nominal stress and fatigue limit of the material control the behavior of the structure. Alternatively, the
relationship between the fatigue life and nominal stress on a complex component such as a weld could be
experimentally determined. Many empirical relationships have been developed during the last 100 years. Standard
weld SN curves such as those from BS5400 can be used, although InField provides a specific BS5400 analysis
module.

The primary limitation of Stress Life analysis is that plastic strains, which are known to be critical to fatigue as
well as the sequence effects that alter the mean stresses at stress concentrations are ignored .

For more information see Fatigue Calculator - Stress Life Fatigue Analysis.

P | oad Life Fatigue Analysis

Load life or component life analysis tests components under constant amplitude loading in the laboratory to
establish baseline data for their durability. This data is then used to estimate how long a component can be
expected to last during variable amplitude service conditions.

The advantage of Load Life analysis is that all variables affecting the fatigue life of the component are included in
the data base (processing variables, local stress concentrations, etc.) Changes in service usage can be assessed
with this approach.

The obvious limitation of Load Life analysis is that it requires extensive testing. It cannot be used to assess design
modifications, nor can mean stress effect be included.

For more information see Fatigue Calculator - Load Life Fatique Analysis.

ﬁ Weld Life Fatigue Analysis

Weld Life or BS5400 analysis is used for analyzing the welded areas of structures. It uses a series of predefined
curves. To pick the SN curve for a particular problem, first classify the weld in accordance with the BS5400
standard. There are seven weld classes: B, C, D, E, F, F2, and W where B is the strongest.

For more information see Fatigue Calculator - Weld Life Fatigue Analysis.
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E Crack Growth Fatigue Analysis

Crack growth analysis uses linear elastic fracture mechanics and related crack growth material properties to
determine how fast a crack or crack-like defect will spread under service loading conditions. This analysis in turn
provides an estimate of the remaining safe life of the structure or component.

For more information see Fatigue Calculator - Crack Growth Fatigue Analysis.

Filtering

The Filtering tools are used to selectively remove unwanted frequency components from sequential data channels
and to upsample or downsample time history data.

M Digital Filter Design

The Digital Filter Design provides a method to design Low Pass, High Pass, Band Stop, and Band Pass filters for
use in data analysis. Filter types include Finite Impulse Response (FIR) and Butterworth.

For more information see Filtering - Digital Filter Design.

Iﬂl Resampling

Resample provides a method to change the number of samples taken from an input channel. This may be necessary
when using a DataMode to combine two channels that may have been collected using different sample rates.

For more information see Filtering - Resampling.

Upsampling

Integer Upsampling analysis uses linear interpolation to upsample time history data channels by whole integer
multiples in order to bring two or more channels up to the same sample rate.The two (2) primary purposes for
this are 1) so that visual data comparisons (with Tabular display, OverPlot, MultiPlot, e.g.) can be performed and
2) so that channels can be plotted against each other using CrossPlot.

Integer Upsamping works only on Time History channels and uses simple linear interpolation; therefore the
frequency content of the channel(s) is distorted.To preserve frequency content, use Resampling analysis.

For more information see Filtering - Upsampling.
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Frequency Analysis

The Frequency Analysis tools are used to determine significant frequencies in time histories and establish the
functional relationships between mechanical system inputs with frequency response functions.

% AutoPower Spectrum Analysis

Using the AutoPower Spectrum Analysis function provides a method to investigate the frequency content of
measured signals, displacements, loads, strains, velocities, accelerations, sound pressure, etc. The methodology
reduces large time histories into smaller amounts of information. Commonly investigated items are:

» Content of steady state sinusoids within complex signals

« Overall signal energy as a function of frequency for optimal sample rate selection
« Broad band signal energy, as a function of frequency, for vibration testing

* Product comparison

The output can be in the form of a Linear Spectrum, AutoPower Spectrum, Power Spectral Density (PSD), or
Energy Spectral Density (ESD).

For more information see Frequency Analysis - AutoPower Spectrum Analysis.

M FRF (Frequency Response Function)

The FRF analysis function provides a method for evaluating the relationship between channels in the frequency
domain. Outputs may include autopower, crosspower, coherence, and frequency response.

For more information see Frequency Analysis - FRF (Frequency Response Function) Analysis.

ﬂ FFT (Fast Fourier Transform)

The FFT analysis function provides a method to translate the selected input channel from the time domain,
amplitude versus time, to the frequency domain, amplitude versus frequency.

For more information see Frequency Analysis - FFT Analysis.

Iﬂl IFFT (Inverse Fast Fourier Transform)

The IFFT analysis function provides a method to translate the selected input channels from the frequency domain,
amplitude versus frequency, to the time domain, amplitude versus time.

For more information see Frequency Analysis - Inverse FFT (Fast Fourier Transform).

Rosette Analysis

The Rosette Analysis function provides a method for converting the three strains from a rosette strain gage
(rectangular or delta) into orthogonal axial strains and/or stresses. Optionally, these can be further resolved into
principal strains, principal stresses, tensile or shear strains at arbitrary angles,Von Mises stress, etc. Rosette strain
gages eliminate the problem of perfectly orienting single strain gages; strain at any angle can be later computed.

For more information see Rosette Analysis.
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Relative Damage Comparitor

The Relative Damage Comparator analysis module calculates the fatigue life of load histories in comparison to
each other. It is primarily used to quickly determine the most damaging load histories from a series of data
channels. The analysis accounts for varying time length channels and uses the total elapsed time to compensate
for the relative fatigue life. Both time and burst histories can be analyzed.

Script Player

The Script Playback dialog is used to activate Visual Basic® scripts containing instructions for sequences of actions
within InField. To start Script Playback either select it from the Tools menu or click the Script Playback button,

E on the toolbar.

=i Script Playback : E x|
Active Script |NEINE j HNOME
Channels

Mew Selected Channels

Help | Edit | Expand ]9 Cancel | HBun |

Script Playback dialog

The Active Script drop-down list contains previously selected scripts allowing for quick selection of commonly
used scripts. The Channels drop-down list contains channel list modifiers which allow for the narrowing of the
channels upon which Script Playback will run.

Buttons
Help - Open the InField help system to the topic directly related to the Script Playback dialog.
Edit - Open a Windows Notepad style window containing the selected script

Expand - Expand the lower section of the window to a Windows file selection type dialog allowing for easy
browsing of the computer file system to locate scripts.

Collapse - Collapse the lower section of the window displaying a Windows file selection type dialog.

OK - Place the Active Script at the default location for the session. This makes running a particular script faster
as it won't require loading each time the Script Playback dialog is selected.

Cancel - Exit the Script Playback dialog.
Run - Execute the script with the selected parameters.
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Statistics
The Statistics function evaluates the basic statistics for channel data and displays those statistics in a text window.

To start Statistics, either select it from the Tools menu or click the Statistics button, % on the application
toolbar.

Sil Statistics x|

Output Statistics Significant Digitz

FileM ame - [ -
Chant ame | J
AuizLabel

itlguuvglrts [v Statz az Rows

#Upper

b @ alue
M alue
b axS5can
MinScan
b anTime
kinTime
kean

StD ey hd

Edit Statistics List

Help | E:-:pu:urt| ] | Ear‘u:e|| gnal_l,lze|

Statistics Dialog Box

Evaluations

The Edit Statistics List button can be used to open a dialog allowing user selection of the fields included in the
evaluation.

The statistics genereated depend on the type of data selected from the Channels List. Fields included that do not
apply to the input data will be assigned a value of “N/A”

Available fields are;

FileName, Channel Name (ChanName), AxisLabel, AxisUnits, XLower, XUpper, MaxValue, MinValue, MaxScan,
MinScan, MaxTime, MinTime, Mean, StdDev, RMS, Variance, Kurtosis, Skewness, CrestFactor, UserMax, UserMin,
OverloadTime and OverloadCounts.

Parameters

The following options are available within the Statistics menu:

Significant Digits - This is the number of significant digits used when displaying the data.

Stats as Rows - Selecting Stats as Rows will display the information as rows rather than columns. This is

beneficial when reviewing large amount of data, and comparing a specific row of this data.
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Buttons

Edit Statistics List - Open a dialog allowing for selection of the fields included for evaluation and modification
of the order in which they are presented after evaluation.

« To remove a field, highlight the field to remove in the right-hand (Selections) window, then click Remove.

«To add a field, highlight the field to add in the left-hand (Candidates) window and click Add.

< To move a field, highlight the field to move and use the Up or Down buttons to relocate the column.
Help - Open the InField help topic directly related to the Statistics tool.

Export - Save the information entered directly to an analysis script (*. ANA) file. This makes it possible to rerun
the same analysis function with the InField Script Player playback dialog.

OK - Save the information entered for future use.
Cancel - Exit Statistics without making any changes or applying any analysis functions.

Analyze - Evaluate the statistics according to the parameters provided and display the information in a new
window.The statistics data entry window will remain visible behind the window generated from the analysis.

Signal Calculator

The Signal Calculator allows the use of mathematical expressions to combine sequential data channels to create
virtual data channels known as computed channels. Most arithmetic, Boolean, trigonometric, and logarithmic
functions are supported by the Signal Calculator.

Calculations are performed using the individual sample data points of the input channel(s). Computations involving
more than one channel are performed using data points of the same sample index from each channel. For
example, the addition of two channels would require adding the first sample data point in each input channel to
achieve the first data point in the computed channel. The second data point in the computed channel would be
the result of the addition of the second data sample point in each of the input channels, and so on.

The number of data points in the resulting computed channel is determined by the number of sample data points
of the input channel(s). The created channel will have the same number of data points as the input channel with
the fewest number of sample data points.

Creating Trigger Channels

To create trigger or logical data channels, enter equations in the Equation Definition box using operators such
as> >= < <=,

Logical/Trigger channels will contain the same number of data points as the data used to create them.The
amplitude value will be 1 when the condition is true and 0 when the condition is false.

Trigger channels are used with DataModes within InField.
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To start the Signal Calculator, either select it from the Tools menu or click the Signal Calculator button, E on
the application toolbar.

=i Signal Calculator x|

Channel Definitian

Narme Inewcomputed = | Units fing | UserMin 100 ~
Description | Computed Usger Max |1|:||:| ﬂ

Equation D efiniti
guation LIefinitan Input Channels

Chanl - B¥CoSinedt100 - Freq «
Chanz - 10 Sinedthd - Frequer |
Chana - Timel_Acceld BM_1 -
Chand - TimeE_.ﬁ.-_:DEIB.HN_'I -
2 R T Y ) e U
4 | 5 | & | * | pi | Exp | log | Clear | = | ar | Chan? - S.&E_Transmis_sin:nn - 5i
Chang - 54E_Suspenzion - 5a
1 | 2 | 3 | - | sin | asin | ||:u;|1IZI| | s | nok | Chan3 - SAE_Bracket - Sae.sif |
i Chan1d - 1g5quarePulze - Sho
abs | o | | + | cos | '3':':'5| diff | | == | | Chan11 - Response Channel -
it | a4t | | N | ban | an | - | | - | e | Chan12 - Force Channel - Spacj
CHep ] Expont | 0K | Cancel | Analyee |
Signal Calculator Dialog Box
Parameters

Channel Definition

Name - The name used to identify a particular Signal Calculator function. This name will also appear in the
Output List to help locate the channel created for future reference.

Units - The units for the resultant data channel. If Default was selected from the drop-down menu, a best-fit
default units string will be applied; it will be the units from the original data-set if all of the combined
channels have the same units.

User Min - User-defined minimum value for the resultant data channel. Two options are available in the drop-
down list:

Default - If the combined channels all have the same user-defined minimum value, it is applied here.
None - A user-defined minimum value is not added to the resultant channel.

User Max - User-defined maximum value for the resultant data channel. Two options are available in the drop-
down list.

Default - If the combined channels all have the same user-defined maximum value, it is applied here.
None - A user-defined maximum value is not added to the resultant channel.
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Description - Used to help identify the channel created by the Signal Calculator. The name entered here will be
shown to the left of the window. (It will also be associated with the entry from the Units field.)

Equation Definition

The area where the actual equations will be entered. There are two ways to enter information:

1. Type the channels and operators. Items must be entered correctly to operate.

2. Using the mouse, select the channels from the Input Channels box and the functions from the Equation
Definition box. Use of this method will help to eliminate any errors caused by typographical errors.

Input Channels

To be available for use the channels must be selected prior to opening the Signal Calculator dialog. If no channels

are listed, see Selecting Data - Selecting Channels from the Channels List.

Operators

This section describes a list of valid operators for the Signal Calculator. Operators work with one or two
operands. The operands can be constants or data channels. Brackets can be used to indicate precedence. All
logical operators are either 0 (false) or 1 (true).

Operator  Operands Meaning Example
- 2 Subtraction Chan 1 - 42
* 2 Multiplication Chan 1 * Chan 2
/ 2 Division Chan 1/ Chan 2
n 2 Raise to an exponent Chan 172
+ 2 Addition Chan 1 + Chan 2
< 2 Less than Chan2 <2
<= 2 Less than or equal to Chan 6 <=7.049
> 2 Greater Than Chan1>21
>= 2 Greater than or equal to Chan 1 >=2.875
abs 1 Absolute Value abs (Chan 1)
dt 1 Ay; sample increment; 1/sample rate dt (Chan 1) * Chan 2
eq 2 Equal to (Chan 1) == (Chan 2)
exp 1 10 raised to an exponent exp (Chan 1)
int 1 Integer value - truncate decimal int (Chan 1)
log 1 Natural logarithm (base e) log (Chan 5)
log 10 1 Logarithm (base 10) log10 (Chan 2)
ne 1 Not Equal to (Chan 1) != (Chan 2)
not 2 Binary Not (Chan 1) ! (Chan 2)
or 2 Binary Or (Chan 1) || (Chan 2)
pi 1 Value of pi Chan1 * pi
sqrt 1 Square Root sgrt (Chan 3)
Ccos 1 Cosine cos (Chan 3)
acos 1 Arccosine acos (Chan 3)
and 2 Binary And (Chan 1) && (Chan 2)
sin 1 Sine sin (Chan 2)
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Desk Calculator Operators (continued)

Operator  Operands Meaning Example
asin 1 Arcsine asin (Chan 1)
tan 1 Tangent tan (Chan 4)
atan 1 Arctangent atan (Chan 2)
diff 1 Derivative diff (Chan 1)
intgn 1 Integral intgn (Chan 1)

Buttons

Help - Open the InField help system to the topic directly related to the Signal Calculator.

Export - Save the information entered directly to an analysis script (*. ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use.
Cancel - Exit the Signal Calculator without making any changes or applying any analysis functions.

Analyze - Perform the functions entered into the Signal Calculator Equation Definition window. The Signal
Calculator dialog will remain visible behind the graph that is generated from the analysis. The Signal
Calculator will also generate a new channel under the Output List tab in the Channels List window.
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Rosette Analysis

Rosette Analysis converts thress strains from a rosette strain gage (rectangular or delta) into orthogonal axial
strains and/or stresses. Optionally, these can be further resolved into principal strains, principal stresses, tensile
or shear strains at arbitrary angles,Von Mises stress, etc. Rosette strain gages eliminate the problem of perfectly
orienting single strain gages; strain at any angle can be later computed with Rosette Analysis.

To start the Rosette Anaylsis, select it from the Tools menu, or click the Rosette Analysis button, ﬂ on the
application toolbar.

nl Rosette Analysis |

Gage and Material |nformation Angles

Rosette Type | Rectangular ﬂ Start m

b odulus Unitz | fesi

zl
Elastic Moduluz, E |3|:||:||:||:| ﬂ
=l

End 180 X

a0 -

[ncrement

Poizzon's F atio ||:|_ 3

Frincipal Strainz E1, E2, THETA :'
Strain Rotations Etheta

Shear Straing Gtheta

Yo Mizes Stress Seq ﬂ

Help | E wpart | k. Eancel| .-’-'-.nal_l,lze|

Rosette Analysis Dialog Box

Parameters

Gage and Material Information
Rosette Type
Rectangular - L1, L2, and L3 are the gauges placed at the 0, 45, and 90 degree positions, respectively.
Delta - L1,L2, and L3 are the gauges placed at the 0, 120, and 240 degree positions, respectively.
e L1,L2 and L3 are Exx, Eyy, Gxy.
None - The input channels are assumed to be Exx, Eyy, and Gxy respectively.
Modulus Units
MPa
ksi
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Elastic Modulus, E - Value indicating the elastic (Young's) modulus ratio of stress to strain of the material as
determined from a monotonic tensile test.

Poisson’s Ratio - Poisson's Ratio is defined as the ratio of lateral strain and axial strain in a cylindrical uniaxial
tension specimen. The value for most metals falls between 0.25 and 0.35.The Poisson's Ratio is bounded by
two theoretical limits: it must be greater than -1 and less than or equal to 0.5.

Angles
Start - The beginning angle for use in calculations.
End - The ending angle for use in calculations.

Increment - The step or increment of the angles to be used in calculations.

Rosette Output Options

Multiple output channels can be generated and placed in the Output List tab of the Channels List window.A check
in the checkbox preceeding each option indicates that data should be generated upon analysis.

Axial Strains Exx, Eyy, Gxy
Principal Strains E1, E2, THETA
Strain Rotations Etheta

Shear Strains Gtheta

Von Mises Stress Seq

Axial Stresses Sxx, Syy, Txy, Ezz
Principal S1,S2, THETA

Stress Rotations Stheta

Shear Stresses Ttheta

Buttons
Help - Open the InField help system to the topic directly related to Rosette Analysis.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be the default.
Cancel - Exit without making any changes.

Analyze - Perform the Rosette Analysis according to the parameters provided. The Rosette Analysis dialog box
will remain visible behind the graph that is generated from the analysis. In addition, the Rosette Analysis will
generate a new channel under the Output List tab in the Channels List window.
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Relative Damage Comparator

The Relative Damage Comparator analysis module calculates the fatigue life of load histories in comparison to
each other. It is primarily used to quickly determine the most damaging load histories from a series of data
channels. The analysis accounts for varying time length channels and uses the total elapsed time to compensate
for the relative fatigue life. Both time and burst histories can be analyzed.

At least two channels must be selected from the Channels List. The first channel selected will be used as the
reference channel to which all subsequent channels will be compared. The reference channel is reported in the
dialog box.

After the analysis is complete, a tabular display appears presenting the results of the analysis. The first three
columns report the relative life. The reference channel will always be reported first and will always have a relative
life of 1. All other channels will be referenced to 1. If a channel has a relative life greater than 1, it indicates that
the channel has a longer fatigue life than the reference channel and therefore is a less damaging load history. If a
channel has a relative fatigue life less than 1, it indicates that the channel has a shorter fatigue life than the
reference channel and therefore is a more damaging load history.

To start the Relative Damage Comparator, select it from the Tools menu.

=k Relative Damage |

Reference Channel:

Example.zif-Sine

gﬂelpé Ex=port ak. | Eancel| gnal_l,lze|

...................

Relative Damage Dialog Box

Parameters

Reference Channel - The host file and channel name of the selected channel.

Outputs

The columns in the output table
Relative Life - There are three relative lives reported for each channel. The three lives are calculated using
damage slopes of 3, 5, and 10. Choosing which damage slope to consider is a function of the
characteristics of the load history. Load histories characterized by a few large damaging cycles would
best be modeled by a damage slope of 10. Load histories characterized by a moderate number of
intermediate cycles would best be modeled by a damage slope of 5. Load histories characterized by
a large number of small cycles would best be modeled by a damage slope of 3.

Min - The minimum load of the channel.
Max - The maximum load of the channel.

Range - The load range of the channel, max minus min. Also the biggest load cycle.
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Elapsed Time - The total elapsed time of the channel. In the case of burst histories, it is the summation
of the elapsed times of each burst.

Cycles - The total number of load cycles in the history.

Seq - The equivalent constant amplitude load. A constant amplitude load history of this magnitude and
number of cycles would do as much damage as the actual data history being analyzed. The equivalent
constant amplitude load is used in the derivation of relative life.

Buttons
Help - Open the InField help system to the topic directly related to the Relative Damage Comparator.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the analysis using the InField Script Player playback dialog.

OK - Save the information entered for future use.These parameters will then be the default.
Cancel - Exit without performing any analysis.

Analyze - Perform the Relative Damage comparison. The Relative Damage dialog box will remain visible behind
the report that is generated from the analysis.
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Derivation of Relative Life

The Load-Life Power Function:

S = So - N®
%
_ s
Nr = (%)
The Linear Damage Rule (Miner’s Rule):
L 1 1
gf = N, + N, +
substituting (2) into (3)
1 1 1
5 T + T +
7 & &)
1 P (g\F
B (2) "+ (%) "+
1 1 " m
gf = (S_o 2.5
Equivalent Load:
Seq = m Z]\fim
Seq™ N = >SS
substituting (8) into (6)
1 1 m m
1 m
- S_eq)
Bf N( So
S, m
By = ¥ (squ)

(1)

where S = load
Sy = intercept of load — life curve at one cycle
Ny = cycles to failure
b = slope of load — life curve

(2)

where By = Blocks to failure
Ny, = Cycles to failure of cycle 1

%

where m = damage slope = —% = 3,5, 10

where S; = load of cycle i
N = number of cycles
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Derivation of Relative Life (continued)

Relative Life:

Relative Life =

Relative Life =

Relative Life =

Life of Channel i

Bfi~Atz‘

Life of Reference Channel - BfTef'Atref

where By, _,

By,
At’l”(if

substituting (11) into (12)

1 So ™
(S5

1 So "
Nres (sequ ) Atyey

Seqres m | Neep-Ats
Seq; N;-Atpey

(12)

blocks to failure of reference channel
blocks to failure of channel i

elapsed time of reference channel
elapsed time of channel i
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DataModes

DataModes determine how and in what form test data will be stored and displayed (i.e. sequential or histogram
plot) A DataMode definition consists of a list of input channels, a data storage/processing rate, triggering
conditions, and other parameters specific to the DataMode.

General Information

Time History

A sequence of constantly sampled data channel values are continuously stored in the output data file. This
DataMode is used to convert time history data channels into shorter time history data by using one of the input
channels as a data trigger. This triggering allows for removal of data before or sampling of data after the occurance
of a specific data condition.

Burst History

A series of fixed-length time histories that are triggered by a user-defined event are stored in the output data file.
This DataMode is used to convert a series of time histories into a series of burst histories by using one of the
input channels as a data trigger. This triggering allows for removal of data before or sampling of data after the
occurance of a specific data condition.

Time-At-Level

A Time-At-Level matrix, a fixed size matrix formed by categorizing constantly sampled data channels and
calculating their frequency of occurance, is stored in the output data file. Each input channel occupies one
dimension of the matrix resulting in a single data object containing the amount of time spent at unique
combinations of variables.

Peak Valley

A collection of successive peaks and valleys, data values where signals change direction, which exceed a user-
specified hysteresis value is stored in the output data file. The data between the signal reversals is not stored.

Peak Valley Matrix

A Peak-Valley matrix, a fixed size matrix formed by categorizing successive peak-valley pairs in sequential data and
representing their frequency of occurance, is stored in the output data file. An input channel may be used as a
data trigger only if all input channels were generated using the same sample rate.

Rainflow

A Rainflow matrix, a fixed size matrix formed by categorizing rainflow peak-valley pairs and representing their
frequency of occurance, is stored in the output data file. An input channel may be used as a data trigger only if all
input channels were generated using the same sample rate.

DataModes ¢ page 63



Use of Triggers

Triggers can be used in DataModes to control or gate the data being processed so as to eliminate undesirable
segments of input data channels. More information regarding triggers and their use can be found under Triggering
Considerations later in this section.

Analysis Procedure
The suggested procedure for running a data validation using InField DataModes is as follows:

NOTE: DataMode dialog boxes are modeless. Clicking outside of a DataMode dialog box will allow
the use of other windows and functions in the open InField session. Click on the related dialog
to return to the DataMode.

1. Select the channel(s) to be validated from the InField channels list. Ensure they are the proper type for the
validation to be performed.

2. Open the dialog box for the DataMode to use and set its analysis parameters as necessary.
3. Click Analyze to run the validation according to the parameters entered.

When the validation is complete, InField will plot the results and add the output channel to the Output List.
If Add Elapsed Time Channel is an available option and is selected, a plot for that time channel will also be
graphed and added to the Output List.

The title bar of each plot window will have the name of the DataMode and the name of the channel being
validated.

The default file name for the analysis file(s) containing output channels is made up of the DataMode name
and the analysis sequence number with a -SIF extension (SoMat Information File). Sequences start at 000.
The sequence number is determined by the previously created output files for the selected function that
exist in the InField installation Output Files directory. The next available sequence number is used for the
newly created file and plot. For example, if there are existing files titled BurstHistory 000.sif and
BurstHistory 001.sif,selecting the Analyze button within a Burst History dialog will create a file titled
BurstHistory 002.sif.

NOTE: Files created in the Output Files directory of the InField installation are not deleted when
InField is exited. Periodic, manual deletion of unnecessary files in this directory is strongly
recommended to conserve disk space on the computer.

4.  Examine the validation results. Channel plot data can be viewed, edited, copied, and pasted using the
functions described in Viewing Data and Editing Data.

5. Review the Output List. Save the channels to keep, and remove the channels to be discarded.

« To save output channels to a file (other than the default), select them and use Save As in the InField File
menu. The saved files will appear in the Output List with the file name specified during the save. The
original, temporary channels can be removed from the Output List.

« To remove channels from the Output List, select the channel(s) to remove and then right-click. Use the
option Remove Channel(s) from Channel List to remove the unwanted channels. It is not necessary
to remove the channels from the Output List. This is really just a way to keep the list manageable and avoid
clutter when validating data.

NOTE:  Exiting InField will not prompt to save the Output List items. Make sure, if there are any items
in the Output List worth saving, to do so before exiting InField.
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Time History

The Time History DataMode is used to convert a series of time histories into another series of time histories by
using one of the input channels as a data trigger. The data trigger channel has to be created before the DataMode
is run. This allows removal of data before or sampling of data after the occurance of a specific data condition.

Data Analyzed

The Time History DataMode can only be used on time history data.All input channels must have the same sample
rate. At least two channels must be selected before using the Time History DataMode. The required channels are
a trigger and a channel for validation.

To start the Time History DataMode, either select it from the DataMode sub-menu of the Tools menu or click

the Time History button, @ on the application toolbar.

ol Time History Data Mode |
Triggering
~
Trigger Mods Triager ﬂ

Trigger Channel

1 - Trigger - Drnodes. sif

Databdode Properties
[ Add Elazped Time Channel

Help | E:-:pu:nrt| k. Ear‘u:el| gnal_l,lze|

Time History DataMode Dialog Box

Parameters

Triggering
Trigger Mode - Type of trigger to be used. Available choices are:
Gate - Sample data only when the trigger channel’s state is “On”.

Trigger - When the trigger channel’s state first changes from “Off” to “On”, start sampling and continue
until the end of the data, regardless of any subsequent change in the trigger channel’s state.

One-Shot - Each time the trigger channel’s state changes from “Off” to “On”, sample data once. As a
special case, if the trigger channel is “On” during the first sample of the data, one data sample is taken.

Trigger Channel - The channel to be used as the trigger channel. The channels selected from the Channels List
will be available in this drop-down box.
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DataMode Properties

Add Elapsed Time Channel - This option is available to add an Elapsed Time Channel to the data being
validated. This may be useful in determining when particular events happened during the test.

Buttons
Help - Open the InField help system to the topic directly related to the Time History DataMode.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be the default.
Cancel - Exit without making any changes or applying any analysis functions.

Analyze - Perform the Time History DataMode according to the parameters selected. The Time History
DataMode dialog box will remain visible behind the graph that is generated from the analysis. In addition,
the Time History DataMode will generate a new channel under the Output List tab in the Channels List
window.

Burst History

The Burst History DataMode is used to convert a series of time histories into a series of burst histories created
by using one of the channels as a data trigger. The data trigger channel must be created before this DataMode is
run. This allows data around certain conditions to be sampled for predefined periods of time.

Data Analyzed

The Burst History DataMode can only be used on time history data.All input channels must have the same sample
rate.At least two channels must be selected before using the Burst History DataMode.The required channels are
a trigger and a channel for validation.
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To start the Burst History DataMode, either select it from the DataMode sub-menu of the Tools menu, or click

the Burst History button, ﬂ on the application toolbar.

&k Burst History Data Mode = x|
Trigaering
[
Trigger Maode ‘when T ﬂ

Trigger Channel

1- TrinEer - Dmodes. sif

D atatdode Properties
MNumber of Bursts |1 ﬂ
Pozt Trigger Time [zecz] |-| ﬂ
Pre Trigger Time [gecs] |-| ﬂ

[ Add Elazped Time Channel

Help | E:-:pu:urt| k. Eanu:el| gnal}lze|

Burst History DataMode Dialog Box
Parameters

Triggering
Trigger Mode - Type of trigger to be used. The following are the selections available:
When True - Sample data only when the trigger channel state is True.

On False-True Transition - Sample bursts only when the trigger channel state changes from False to
True.

Trigger Channel - The channel to be used as the trigger channel. The channels highlighted in the Channels List
will be available in this drop-down box. Make sure the channel is an appropriate channel for use as a trigger,
or the Burst History DataMode may not analyze data correctly.

DataMode Properties

Number of Bursts - The maximum number of bursts to record. The number of bursts recorded may be less
than the selected value if the trigger condition is not met as many times as the selected value.

Post Trigger Time (secs) - Amount of data, in seconds, to store after the burst occurrence.

Pre Trigger Time (secs) - Amount of data, in seconds, to store before the burst occurrence.
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Add Elapsed Time Channel - This option is available to add an Elapsed Time Channel to the data being
validated. This may be useful in determining when particular events happened during the test.

Buttons
Help - Open the InField help system to the topic directly related to Burst History DataMode.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be the default.
Cancel - Exit without making any changes or applying any analysis functions.

Analyze - Perform the analysis according to the parameters selected. The Burst History DataMode analysis
dialog will remain visible behind the plot window that is generated by the analysis. The analysis will also
generate and add a data channel to the Output List tab in the Channels List window.

Peak Valley

The Peak Valley DataMode is used to convert a series of time histories into a series of successive peaks and
valleys. One of the input channels is selected as a master channel. Whenever there is a peak or valley on the
selected channel, all of the channels are sampled. A trigger channel can be defined, which allows for pre-filtering
the data.

Data Analyzed
The Peak Valley DataMode accepts any sequential data. The selected channels must have the same sample rate.

To start the Peak Valley DataMode, either select it from the DataMode sub-menu of the Tools menu, or click the

Peak Valley button, ﬂ on the application toolbar.

oW Peak ¥Yalley Data Mode i |

Triggering

[vw lze Trigoer

Trigger Mode | Trigger ﬂ
Trigger Channel . Sirain_bd% - Dmades.s ¥ |

Databdode Properties

Master Channel |EI - Shrain_b4s - Dmndes.sﬂ
Huysteresis ||:|_1 ﬂ

[ Add Elazped Time Channel
[v P Slice Mode

Help | E:-:pu:nrt| k. Ear‘u:el| gnal_l,lze|

Peak Valley DataMode Dialog Box
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Parameters

Triggering
Trigger Mode - Type of trigger to be used. The following selections are available:
Gate - Sample data only when the trigger channel’s state is “On”.

Trigger - When the trigger channel’s state first changes from “Off” to “On”, start sampling and continue
until the end of the data, regardless of any subsequent change in the trigger channel’s state.

One-Shot - Each time the trigger channel’s state changes from “Off” to “On”, sample data once.As a
special case, if the trigger channel is “On” during the first sample of the data, one data sample is taken.

Trigger Channel - The channel to be used as the trigger channel. The channels selected from the Channels List
will be available in this drop-down box.

DataMode Properties

Master Channel - Only valid while in PV Slice mode. The channel from which the peaks and valleys are
extracted.

Hysteresis - The hysteresis value is used to eliminate small reversals in the peak valley data stream and should
be expressed in the same units as the data being analyzed. Adjacent peaks and valleys will always differ by
more than the hysteresis value. A value of O causes all reversals to be stored.

« This may also be referred to as noise band, gate, and hysteresis gate.

Add Elapsed Time Channel - This option is available to add an Elapsed Time Channel to the data that is being
analyzed. This may be useful in determining when particular events happened during the test.

PV Slice Mode - When a peak or valley occurs in the Master Channel, the values in all other channels (slaves)
will be sampled simultaneously. The results of the slave channels will not be peaks or valleys but rather the
data at the peak or valley in the Master Channel.

Buttons
Help - Open the InField help system to the topic directly related to Peak Valley DataMode.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be the default.
Cancel - Exit without making any changes or applying any analysis functions.

Analyze - Perform the Peak Valley DataMode according to the parameters provided. The Peak Valley DataMode
window will remain visible behind the graph that is generated from the analysis. In addition, the Peak Valley
DataMode will generate a new channel under the Output List tab in the Channels List window.

Peak Valley Matrix

The Peak Valley Matrix DataMode converts time histories into Peak Valley Matrices. One of the input channels can
be used as a trigger channel, if so desired.
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Data Analyzed

The Peak Valley Matrix DataMode accepts only sequential data. Triggering options will be available only if the input
channels have the same sample rate.

To start the Peak Valley Matrix DataMode, either select it from the DataMode sub-menu of the Tools menu or

click the Peak Valley Matrix button, H on the application toolbar.

nkPeak Yalley Matrix DataMode i ﬂ

Triggering

[v ze Trigger

Trigger Mode Trigaer ﬂ
Trigger Channel

1 - Trigger - Drnodes. sif

[ atatode Properties
Hysteresis ||:|_1
Mode | Range-Mean

Murnber of Binz |1 0

Bin Type |Evenly Divided
Mir. Armplibude |.'| o0

KN EN|EREN|ENIEN

Max Amplitude |1 0o

Edit Binz

Help | E:-:pn:nrt| (] % Eann::el| gnal_l,lze|

Peak Valley Matrix DataMode Dialog Box
Parameters

Triggering
Trigger Mode - Type of trigger to be used. The following selections are available:
Gate - Sample data only when the trigger channel’s state is “On”.

Trigger - When the trigger channel’s state first changes from “Off” to “On”, start sampling and continue
until the end of the data, regardless of any subsequent change in the trigger channel’s state.

One-Shot - Each time the trigger channel’s state changes from “Off” to “On”, sample data once.As a
special case, if the trigger channel is “On” during the first sample of the data, one data sample is taken.

Trigger Channel - The channel to be used as the trigger channel. The channels selected from the Channels List
will be available in this drop-down box.
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DataMode Properties

Hysteresis - The hysteresis value is used to eliminate small reversals in the peak valley matrix data stream and
should be expressed in the same units as the data being analyzed. Adjacent peaks and valleys will always
differ by more than the hysteresis value.A value of 0 causes all reversals to be stored.

« This may also be referred to as noise band, gate, and hysteresis gate.

Mode - Type of matrix in which the results will be stored. Selections available are Range-Mean, Range-Only, and
To-From.

Number of Bins - Number of bins into which the dimension is to be divided. There will always be an underflow
and overflow in addition to the number specified.

Bin Type - Type of bin to be used in storing data. There are two choices for bin type:
Evenly Divided - All the bins are the same size, divided equally across the data range.

User Defined - The maximum amplitude value for each bin is user-defined. This also includes defining the
underflow bin.When User Defined is selected, the User Bin Table becomes available for editing.

Min Amplitude - Lower limit of amplitude analysis range.
Max Amplitude - Upper limit of amplitude analysis range.

Edit Bins - Open the User-Defined Bin Setup dialog box. Number of Bins, Bin Type, Min and Max Amplitude are
repeated in the sub-window. New options within this window are:

User Bin Table - Only available for editing when User Defined is selected as Bin Type. Used to specify the
maximum amplitude value for each bin, including the underflow bin. The number of available entries
will be the number of bins plus 1.1f 10 bins are selected in the Number of Bins, there will be 11 entries
required, due to the underflow entry required. See Editing Bin Information later in this section for
more information.

Import - Provides a method to load a user bin definition previously saved using the Export button.When
Import is selected, a dialog box will open, providing a method to select any previously saved user-
defined bins.

Export - Provides a method to save a user bin definition previously created in the User Bin Table. When
Export is selected, a dialog box will open, providing a method to name and save any definitions created
or modified.

Fill In Even Bins - Provides a method to fill in the values of the bins with a predefined set of values as
determined in InField. These values will reflect the Max and Min values, as well as the number of bins
selected.
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Buttons
Help - Open the InField help system to the topic directly related to Peak Valley Matrix DataMode.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be default.
Cancel - Exit without making any changes or applying any analysis functions.

Analyze - Perform the Peak Valley Matrix DataMode according to the parameters selected. The Peak Valley
Matrix DataMode dialog box will remain visible behind the graph that is generated from the analysis. In
addition, the Peak Valley Matrix DataMode will generate a new channel under the Output List tab in the
Channels List window.

Rainflow

The Rainflow DataMode converts sequential data channels into rainflow matrices that are typically used in low-
cycle fatigue damage analysis. One of the input channels can be used as a trigger channel, if so desired.

Data Analyzed

The Rainflow DataMode accepts only sequential data. Triggering options will be available only if the input channels
have the same sample rate.
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To start the Rainflow DataMode, either select it from the DataMode sub-menu of the Tools menu or click the

x|
Trigaering
v Usze Trigger
Trigger Mode Trigger ﬂ
Trigger Channel 1- Triner - Dimodes. sif
D atatdode Properties
Huysteresis ||:|_-| ﬂ
Mode | Fange-tMean ﬂ
Mumnber of Bins |-| 0 ﬂ
Bin Type |Evenly Divided |
Min. Armplitude |.-| an ﬂ
M ax. Amplitude |-| o0 ﬂ
Edit Bins |
Help | Esport | k. Cancel | Analyze |

Rainflow DataMode Dialog Box

Parameters

Triggering
Trigger Mode - Type of trigger to be used. The following selections are available:
Gate - Sample data only when the trigger channel’s state is “On”.

Trigger - When the trigger channel’s state first changes from “Off” to “On”, start sampling and continue
until the end of the data, regardless of any subsequent change in the trigger channel’s state.

One-Shot - Each time the trigger channel’s state changes from “Off” to “On”, sample data once. As a
special case, if the trigger channel is “On” during the first sample of the data, one data sample is taken.

Trigger Channel - The channel to be used as the trigger channel. The channels selected from the Channels List
will be available in this drop-down box.
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DataMode Properties

Hysteresis - The hysteresis value is used to eliminate small reversals in the peak valley matrix data stream, and
it should be expressed in the same units as the data being analyzed. Adjacent peaks and valleys will always
differ by more than the hysteresis value.A value of 0 causes all reversals to be stored.

« This may also be referred to as noise band, gate, and hysteresis gate.

Mode - Type of matrix into which the results will be stored. Selections available are Range-Mean, Range-Only, and
To-From.

Number of Bins - Number of bins into which the dimension is to be divided. There will always be an underflow
and overflow in addition to the number specified.

Bin Type - Type of bin to be used in storing data. There are two choices for bin type:
Evenly Divided - All the bins are the same size, divided equally across the data range.

User Defined - The maximum amplitude value for each bin is user-defined. This also includes defining the
underflow bin.When User Defined is selected, the boxes for specifying the minimum and maximum
values for each bin become available.

Min Amplitude - Lower limit of amplitude analysis range.
Max Amplitude - Upper limit of amplitude analysis range.

Edit Bins - Open the User-Defined Bin Setup dialog box. Number of Bins, Bin Type, Min and Max Amplitude are
repeated in the sub-window. New options within this window are:

User Bin Table - Only available for editing when User Defined is selected as Bin Type. Used to specify the
maximum amplitude value for each bin, including the underflow bin. The number of available entries
will be the number of bins plus 1.1f 10 bins are selected in the Number of Bins, there will be 11 entries
required, due to the underflow entry required. See Editing Bin Information later in this section for
more information.

Import - Provides a method to load a user bin definition previously saved using the Export button.When
Import is selected, a dialog box will open, providing a method to select any previously saved user-
defined bins.

Export - Provides a method to save a user bin definition previously created in the User Bin Table. When
Export is selected, a dialog box will open, providing a method to name and save any definitions created
or modified.

Fill In Even Bins - Provides a method to fill in the values of the bins with a predefined set of values as
determined in InField. These values will reflect the Max and Min values, as well as the number of bins
selected.
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Buttons
Help - Open the InField help system to the topic directly related to Rainflow DataMode.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be default.
Cancel - Exit without making any changes or applying any analysis functions.

Analyze - Perform the Rainflow DataMode analysis according to the parameters selected. The Rainflow
DataMode dialog box will remain visible behind the graph that is generated from the analysis. In addition,
the Rainflow DataMode will generate a new channel under the Output List Tab in the Channels List window.

Time-At-Level

The Time-At-Level DataMode converts a series of time histories into a multidimensional Time-At-Level Matrix.
For each input channel, there will be one dimension. For each sample, the algorithm classifies each input channel
amplitude into a bin within its respective dimension. The maximum number of input channels is six, limiting the
output dimensions. Plotting and displaying large amounts of data can be very laborious for a large matrix
(approximately 12MB of data if each dimension was classified into 10 bins). A data trigger can be defined if
required.

Data Analyzed

Time-At-Level DataMode accepts only sequential data. All input channels must have the same sample rate.
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To start the Time-At-Level DataMode, either select it from the DataMode sub-menu of the Tools menu or click

the Time-At-Level button, ﬂ on the application toolbar.

=k Time At Level DataMode x|
Channel #Binz | Bin Type | kdin .-’-'-.mpl| b & Amp
Strain_b4a 10 Ewvenly Divided 100 100
Trigger 10 Ewvenly Divided 100 100
Edit Binz
Triggering
[w Uze Trigger
Trigger Mode | Trigger ﬂ

Trigger Channel

|EI - Strain_b48 - Dmndes.sﬂ

Help | E:-:pu:urt| k.

Cancel | 5nal_uze|

Parameters

Triggering

Time-At-Level DataMode Dialog Box

Trigger Mode - Type of trigger to be used. The following selections are available:

Gate - Sample data only when the trigger channel’s state is “On”.

Trigger - When the trigger channel’s state first changes from “Off” to “On”, start sampling and continue
until the end of the data, regardless of any subsequent change in the trigger channel’s state.

One-Shot - Each time the trigger channel’s state changes from “Off” to “On”, sample data once. As a
special case, if the trigger channel is “On” during the first sample of the data, one data sample is taken.

Trigger Channel - The channel to be used as the trigger channel. The channels selected from the Channels List
will be available in this drop-down box.
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Edit Bins - Open the User-Defined Bin Setup dialog box. Number of Bins, Bin Type, Min and Max Amplitude are
repeated in the sub-window. New options within this window are:

User Bin Table - Only available for editing when User Defined is selected as Bin Type. Used to specify the
maximum amplitude value for each bin, including the underflow bin. The number of available entries
will be the number of bins plus 1.1f 10 bins are selected in the Number of Bins, there will be 11 entries
required, due to the underflow entry required. See Editing Bin Information later in this section for
more information.

Import - Provides a method to load a user bin definition previously saved using the Export button.When
Import is selected, a dialog box will open, providing a method to select any previously saved user-
defined bins.

Export - Provides a method to save a user bin definition previously created in the User Bin Table. When
Export is selected, a dialog box will open, providing a method to name and save any definitions created
or modified.

Fill In Even Bins - Provides a method to fill in the values of the bins with a predefined set of values as
determined in InField. These values will reflect the Max and Min values, as well as the number of bins
selected.

Buttons
Help - Open the InField help system to the topic directly related to the Time-At-Level DataMode.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. The parameters will then be the default.
Cancel - Exit without making any changes or applying any analysis functions.

Analyze - Perform the Time-At-Level DataMode according to the parameters selected. The Time-At-Level
DataMode dialog box will remain visible behind the graph that is generated from the analysis. In addition,
the Time-At-Level DataMode will generate a new channel under the Output List tab in the Channels List
window.

Triggering Considerations

Triggering Overview

Triggering provides a method to eliminate unwanted data from input data channels before the data stream is
processed by a DataMode. Within InField, a trigger acts as a pipe or filter to the input data, thus controlling the
data stream passed into a DataMode.

All the DataModes that allow for triggering will accept a data channel as a trigger. The trigger channel is not
analyzed.

To create a trigger channel, use the InField Signal Calculator. See Validation Tools - Signal Calculator in this manual.

Two sets of trigger types are used in InField: a standard set for all DataModes (except for Burst Histories) and a
set for Burst Histories. These trigger-type sets are described below.
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Trigger States

The trigger channel is assumed to be in an Off state when the channel’s value is in the range of £0.01; otherwise,
it is assumed to be On.

Standard Triggers
The available standard trigger types (excluding bursts) are:
Always On - Sample all the data (no trigger in use).
Gate - Sample data only when the trigger channel’s state is “On”.

Trigger - When the trigger channel’s state first changes from “Off” to “On”, start sampling and continue
until the end of the data, regardless of any subsequent change in the trigger channel’s state.

One-Shot - Each time the trigger channel’s state changes from “Off” to “On”, sample data once.As a
special case, if the trigger channel is “On” during the first sample of the data, one data sample is taken.

Burst Triggers

A burst trigger acts to cause a burst to be recorded. Two different burst triggers are available.
When True - Sample bursts only while the trigger channel state is True.

On False-True Transition - Sample bursts only when the trigger channel state changes from False to
True.
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Editing Bin Information

When the Edit Bin button is selected, the User-Defined Bin Setup dialog box will open. The dialog box shown
below is used in common between Peak Valley Matrix, and Rainflow, and Time-At-Level DataModes.

18

Edit Histogram Axis x|
Datakd ode Properties

Mumber of Binz ﬂ

Bin Type |Everly Divided 7|

Mir. Amplitude |.-| oo ﬂ

b 2w Amplitude |-| oo ﬂ
Lzer Bin Table

Irpirt | Expart |
Fil In Even Bins | oK | Cancel |

Edit Bins Dialog Box

It is here that the definitions of the bins for each dimension of histograms can be edited. The figure shown above
is as it initially appears (the default Bin Type is Evenly Divided).

Click OK to close and save the changes made in the Edit Bins dialog box. Click Cancel to exit without making

changes.

Parameters

DataMode Properties

Number of Bins - Number of bins into which the dimension is to be divided. There will always be an underflow
and overflow in addition to the number specified.

Bin Type- Type of bin to be used in storing data. There are two choices for bin type:

Evenly Divided - All the bins are the same size, divided equally across the data range.

User Defined - The maximum amplitude value for each bin, including the uderflow bin, is user-defined.
When User Defined is selected, the User Bin Table becomes available for editing.
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Min Amplitude - Lower limit of amplitude analysis range.

Max Amplitude - Upper limit of amplitude analysis range.

User Bin Table

Used to specify the maximum amplitude value for each bin, including the underflow bin. The humber of available
entries will be the number of bins plus 1. If 10 bins are selected in the Number of Bins, there will be 11 entries
required, due to the underflow entry required.

Import - Provides a method to load a user bin definition previously saved using the Export button.When Import
is selected, a dialog box will open, providing a method to select any previously saved user bin definition.

Export - Provides a method to save a user bin definition previously created in the User Bin Table.\When Export
is selected, a dialog box will open, providing a method to name and save any definitions created or modified.

Fill In Even Bins - Provides a method to fill in the values of the bins with a predefined set of values as
determined in InField. These values will reflect the Max and Min values, as well as the number of bins
selected.

Buttons
OK - Save the information entered for future use. These parameters will then be default.

Cancel - Exit without making any changes.
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Fatigue Calculator

Load Life Fatigue

Load Life or Component Life Analysis tests components under constant amplitude loading in the laboratory to
establish baseline data for their durability. This data is then used to estimate how long a component can be
expected to last during variable amplitude service conditions.

The advantage of Load Life Analysis is that all variables affecting the fatigue life of the component are included in
the data base (processing variables, local stress concentrations, and so on). Changes in service usage can be
assessed with this approach.

The obvious limitation of Load Life Analysis is that it requires extensive testing. It cannot be used to assess design
modifications, nor can mean stress effect be included.

To start Load Life Analysis, select it from the Fatigue Damage sub-menu of the Tools menu, or click the Load Life

button, M on the toolbar.

=¥ Load Life Fatigue |
Channel: Allmodes. sif-TimeHiztE
Parameters
Scale Factor
|1— Detailz
Component Constant Amplitude
Frant Asle Mir. Load Max. Load
1000 11000
Load | Save |
L4 Prediction
Help | Expart | k. | Cancel | gnal_l,lze|

Load Life Fatigue Dialog Box

Parameters
Channel - The first channel selected in the Channels List is the variable amplitude service history to be analyzed.

Parameters

Scale Factor - Multiplier value for the input data. Changing this value illustrates how increasing or decreasing
the amplitude of the service history affects the fatigue life.
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Details - Display a special dialog for specifying all of the parameters for the analysis. See Load Life Fatigue -
Details Dialog for more information.

Component
Description of the component load-life curve used in this analysis.

Load - Browse the computer file system for an InField Load Life Component File (*.LLF) to load. After the file
is loaded, the Details dialog is opened.

Save - Save an InField Load Life Component File (*.LLF) for future use.
pN Plot - Display the load amplitude versus life plot for the component properties specified.

Constant Amplitude

Min. Load - Minimum load (valley) of the constant amplitude cycle to be analyzed. It should be in the same units
as the load-life curve.

Max. Load - Maximum load (peak) of the constant amplitude cycle to be analyzed. It should be in the
same units as the load-life curve.

CA Prediction - Predict the number of constant amplitude cycles the component can withstand before
failure. The cycle is defined by the maximum and minimum loads specied above. See Load Life
Fatigue - Contstant Amplitude (CA) Prediction Dialog for more information.

Buttons
Help - Open the InField help system to the topic directly related to Load Life Fatigue Analysis.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be the default.
Cancel - Exit without saving changes or applying any analysis functions.

Analyze - Perform the Load Life Fatigue Analysis according to the parameters provided. The Load Life Fatigue
dialog box will remain visible behind the Load Life Fatigue Report that is generated from the analysis.
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Load Life Fatigue - Details Dialog
This standard properties dialog lets you edit all of the available parameters for Load Life Analysis.

a¥- LoadLife

Scale Fackor 1
=B Component Properties
Camponent Mame Front &xle
LLI 100
LLS -0
Fatigue Limit Cycles 10000000
= Output Options
Cyrle Histogram False
Damage Hiskogram  False
Material Properties  False
Exceedance Diagram False

Load Life Details Dialog Box

General

Scale Factor - Multiplier value for the input data. Changing this value illustrates how increasing or decreasing
the amplitude of the service history affects the fatigue life.

Component Properties
Component Name - A brief description of the component being analyzed.

LLI - The intercept at 1 cycle on a log-log plot of load amplitude versus cycles to failure. It should be in the same
units as the signal being analyzed.

LLS - The slope of the straight line from a log-log plot of load amplitude versus cycles to failure. It should be a
negative number of magnitude less than 1.

Fatigue Limit Cycles - The number of cycles considered to represent infinite life.
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Output Options

Cycle Histogram - Add a range versus mean cycle histogram to the results file.

Damage Histogram - Add a range versus mean histogram indicating the damaging cycles to the results file.
Material Properties - Add an XY channel containing a load amplitude versus life diagram to the results file.

Exceedance Diagram - Add a cumulative count to the results file of how many times peaks in the data
exceeded a specified level. How long the peaks exceed the level is not measured. The exceedance diagram
can be either peak-valley or range-pair.

Load Life Fatigue - Constant Amplitude (CA) Prediction Dialog
Constant amplitude Load Life Analysis produces the following results table.

3 Constant Ampltude: I x

LoaDS LIFE ESTIMATE

Cyiles Ta Failure MOT FATIGUE
in. Imgat -1000.00
M. Input 1000.00

COMPOMEMT PROPERTIES

Component Mame Front Axle
Curve Intercept 100

Curve Slope =000
Fat. Litnit Cycles 10000000

Load Life Constant Amplitude Prediction Dialog Box

Load Life Estimate

Cycles to Failure - Number of constant amplitude cycles the component can withstand before failure.The cycle
is defined by the maximum and minimum loads specified below. NOT FATIGUE means the input load
amplitude exceeds the load-life curve intercept. INFINITE means the input load amplitude is less than the
load-life curve value at the fatigue limit cycles.

Min. Input - Minimum load (valley) of the constant amplitude cycle analyzed.

Max. Input - Maximum load (peak) of the constant amplitude cycle analyzed.

Component Properties

Component Name - Description of the component analyzed.

Curve Intercept - The intercept at 1 cycle on a log-log plot of load amplitude versus cycles to failure.
Curve Slope - The slope of the straight line from a log-log plot of load amplitude versus cycles to failure.

Fat. Limit Cycles - The number of cycles considered to represent infinite life.
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Load Life Fatigue Report
A successful variable amplitude Load Life Analysis produces the following results table.

ok Load Life Report

LOADS LIFE ESTIMATE

Blocks Ta Failure MOT FATIGUE - Maximum Data Amplitude of 662 64 iz larger than the Load life Intercept of 10
Hours Ta Failure [ia,

Mirn. Irpoust -999.00

Wz Inpurt 33825

IMPUT CHARMEL IMFORMATICN

Filename COProgram FilesSolatUnField Examples\alimode s zif
ChannelMatme TimeHi=tB

Channel Label Strain

Channel Units uE

Timeslice 0.000 to 2784 444 seconds

COMPOMENT PROPERTIES

Camponert Mame Front Axle

Curve Intercept 100

Curve Slope -0.100

Fat. Litmit Cycles qa0o0a0o

Load Life Report Dialog Box

Load Life Estimate

Blocks to Failure - Number of repeats of the service history (input channel) the component can withstand
before failure. NOT FATIGUE means the maximum input load amplitude from the service history exceeds
the load-life curve intercept. INFINITE means the maximum input load amplitude from the service history
is less than the load-life curve value at the fatigue limit cycles.

Hours to Failure - Number of hours corresonding to the blocks to failure. It equals blocks to failure times the
number of hours in one history repeat.

Min. Input - Minimum data point in the input service history.

Max. Input - Maximum data point in the input service history.

Input Channel Information

Filename - Path and file name of the service history analyzed.
Channelname - Channel name identifier of the service history analyzed.
Channel Label - Extended channel descriptor of the service history analyzed.
Channel Units - Engineering units of the service history analyzed.

TimeSlice - The beginning and ending times for the segment of service history analyzed. Expressed in seconds.
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Component Properties

Component Name - Description of the component analyzed.

Curve Intercept - The intercept at 1 cycle on a log-log plot of load amplitude versus cycles to failure.
Curve Slope - The slope of the straight line from a log-log plot of load amplitude versus cycles to failure.

Fat. Limit Cycles - The number of cycles considered to represent infinite life.

Stress Life Fatigue

Stress Life Analysis is often used for long lives where plastic strains can be ignored. The approach assumes that
the nominal stress and fatigue limit of the material control the behavior of the structure. Alternatively, the
relationship between the fatigue life and nominal stress on a complex component such as a weld could be
experimentally determined. Many empirical relationships have been developed during the last 100 years. Standard
weld SN curves such as those from BS5400 can be used, although InField provides a specific BS5400 analysis
module.

The primary limitation of Stress Life Analysis is that plastic strains, which are known to be critical to fatigue, as
well as the sequence effects that alter the mean stresses at stress concentrations are ignored.

To start Stress Life Analysis, select it from the Fatigue Damage sub-menu of the Tools menu, or click the Stress

Life button, ﬂ on the toolbar.

=l Stress Life Fatigue ; x|

Channel: &llmodes. zif-TimeH izt

Parameters
Scale Factor Motch Factor
1 1 Detailz
M atenal Conztant Amplitude
1020 HE Mir. Strain Max. Strain
1000 11000
Load | Save |
L& Prediction
Help Expart ()% Cancel |  Analyze

Stress Life Fatigue Dialog Box
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Parameters

Channel - The data file and channel name to analyze.

Parameters

Scale Factor - Multiplier value for the input data. Changing this value illustrates how increasing or decreasing
the amplitude of the service history affects the component life.

Notch Factor - Fatigue notch factor value related to the theoretical stress concentration factor of a given notch
geometry. This should be greater than or equal to 1;a value of 1 represents no notch intensification.

Details - Display a special dialog for specifying all the parameters for the analysis.

Material
Description of the stress-life curve used in this analysis.

Load - Browse the computer file system for an InField Materials File (*. 11 ) to load. After the file is loaded, the
Details window is opened.

Save - Create an InField Stress Life Material file (*.sI¥).

sN Plot - Displays a plot of the stress life curve for the material based on the defined parameters.

Constant Amplitude

Max. Strain - The minimum strain (valley) of the constant amplitude strain cycle to be analyzed. It should be in
units strain or microstrain.

Min. Strain - The maximum strain (peak) of the constant amplitude strain cycle to be analyzed. It should be in
units strain or microstrain.

CA Prediction - Predict the number of constant amplitude cycles the component can withstand before failure.
The cycle is defined by the maximum and minimum strains specified above.

Buttons
Help - Open the InField help system to the topic directly related to Stress Life Fatigue Analysis.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use.These parameters will then be the default.
Cancel - Exit without saving changes or applying any analysis functions.

Analyze - Perform the Stress Life Fatigue Analysis according to the parameters provided. The Stress Life Fatigue
dialog box will remain visible behind the Stress Life Fatigue Report that is generated from the analysis.
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Stress Life Fatigue - Details Dialog
This standard properties dialog lets you edit all of the available parameters for Stress Life Analysis.

=k StressLife = |O] x|
BN General ]
Scale Fackar 1
Motch Fackar 1

Mean Stress Rule Goodman
Fatigue Limit Cycles 10000000

Darnage Surn 1
B Material Properties
Material Mane 1020 HR

Elastic Modulus, E- 30000
IItimate Skrengkh 120

S Inktercepk 100

SN Slope -0
B Dutput Options

Cwele Histogram False

Damage Histogram  False
Material Properties  False
Exceedance Diagram False

Stress Life Details Dialog Box

General

Scale Factor - Multiplier value for the input data. Changing this value illustrates how increasing or decreasing
the amplitude of the service history affects the component life.

Notch Factor - Fatigue notch factor value related to the theoretical stress concentration factor of a given notch
geometry. This should be greater than or equal to 1;a value of 1 represents no notch intensification.

Mean Stress Rule - Stress model used: either the Goodman model, Gerber model, or None (no mean stress
correction). Mean stress correction accounts for the fact that cycles with equivalent amplitudes but higher
mean stresses are more damaging in fatigue.

Fatigue Limit Cycles - The number of cycles considered to represent infinite life.

Damage Sum - The damage summation in Miner's Law can be set to a number other than 1.0.

Fatigue Calculator ¢ page 88



Material Properties
Material Name - Brief description of the material whose parameters are defined.

Elastic Modulus, E - Value indicating the elastic (Young’s) modulus ratio of stress to strain of the material as
determined from a monotonic tensile test.

Ultimate Strength - (Su) Value indicating the ultimate strength of the material - the highest engineering stress
that was reached by a material specimen during a monotonic tensile test.

SN Intercept - Intercept at 1 cycle on a log-log plot of stress amplitude versus cycles to failure. If this value is
changed, the Fatigue Limit Stress field will be reevaluated.

SN Slope - Slope of the straight line from a log-log plot of stress amplitude versus cycles to failure. It should be
a negative number less than 1. If this value is modified, the Fatigue Limit Stress field will be reevaluated.

Output Options

Cycle Histogram - Add a range versus mean cycle histogram to the results file.

Damage Histogram - Add a range versus mean histogram indicating the damaging cycles to the results file.
Material Properties - Add an XY channel containing a stress amplitude versus life diagram to the results file.

Exceedance Diagram - Add a cumulative count to the results file of how many times peaks in the data
exceeded a specified level. How long the peaks exceed the level is not measured. The exceedance diagram
can be either peak-valley or range-pair.

Stress Life Fatigue - Constant Amplitude (CA) Prediction Dialog
Constant amplitude Stress Life Analysis produces the following results table.

=IE
STRE=S LIFE ESTIMATE
Cycles Ta Failure 1 E94E+05
Miry. Inpost -1000.00
Mz, Input 1000.00
STRESS LIFE PARAMETERS
Mean Stress Model Gaodman
Motch Factar 1.00
MATERIAL PROPERTIES
Material Matme 1020 HR
Ela=tic Modulus 30000
Uttimate Strencth 120
Curve Intercept 100
Curve Slope -0.00
Fat. Limit Cycles 0000a0o

Stress Life Constant Amplitude Prediction Dialog Box
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Stress Life Estimate

Cycles to Failure - Number of constant amplitude cycles the component can withstand before failure. The cycle
is defined by the maximum and minimum loads specified below. NOT FATIGUE means the input load
amplitude exceeds the load-life curve intercept. INFINITE means that the input load amplitude is less than
the load-life curve value at the fatigue limit cycles.

Min. Input - Minimum strain (valley) of the constant amplitude cycle analyzed.

Max. Input - Maximum strain (peak) of the constant amplitude cycle analyzed.

Stress Life Parameters

Mean Stress Model - Stress model used: either the Goodman model, Gerber model, or None (no mean stress
correction). Mean stress correction accounts for the fact that cycles with equivalent amplitudes but higher
mean stresses are more damaging in fatigue.

Notch Factor - Fatigue notch factor value related to the theoretical stress concentration factor of a given notch
geometry. This should be greater than or equal to 1;a value of 1 represents no notch intensification.

Material Properties
Material Name - Brief description of the material whose parameters are defined.

Elastic Modulus - Value indicating the elastic (Young's) modulus ratio of stress to strain of the material as
determined from a monotonic tensile test.

Ultimate Strength - (Su) Value indicating the ultimate strength of the material - the highest engineering stress
that was reached by a material specimen during a monotonic tensile test.

Curve Intercept - Intercept at 1 cycle on a log-log plot of stress amplitude versus cycles to failure.

Curve Slope - Slope of the straight line from a log-log plot of stress amplitude versus cycles to failure. It should
be a negative number less than 1.

Fat. Limit Cycles - The number of cycles considered to represent infinite life.
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Stress Life Fatigue Report
A successful variable amplitude Stress Life Analysis produces the following results table.

=l Stress Life Report

=TRE=% LIFE EZTIMATE

Blocks To Failure IMFIMITE - Maximum Data Amplitude of 2006 iz smaller than the stress st the fatigue limit of 19,
Hours Ta Failure Pdia,

Mire. Inpoust -999.00

Mz, Input 33825

IMPUT CHAMMEL IMFORMATICHN

Filename COProgram Files'SobatInField Examplesialimodes zif
ChannelMame TimeHi=tB

Channel Label Strain

Channel Units uE

Timeslice 0.000 to 2754 444 seconds

STREZZ LIFE PARAMETERS

Mean Stress Model Goodman
Motch Factar 1.00
MATERIAL PROPERTIES

Materizl Matne 1020 HR
Ela=tic Modulus 30000
Uitimate Strencth 120
Curve Intercept 100

|

Stress Life Report Dialog Box

Stress Life Estimate

Blocks to Failure - Number of repeats of the service history (input channel) the component can withstand
before failure. NOT FATIGUE means the maximum input load amplitude from the service history exceeds
the load-life curve intercept. INFINITE means the maximum input load amplitude from the service history
is less than the load-life curve value at the fatigue limit cycles.

Hours to Failure - Number of hours corresponding to the blocks to failure. It equals blocks to failure times the
number of hours in one history repeat.

Min. Input - Minimum data point in the input service history.

Max. Input - Maximum data point in the input service history.

Input Channel Information
Filename - Path and filename of the service history analyzed.
Channelname - Channel name identifier of the service history analyzed.

Channel Label - Extended channel descriptor of the service history analyzed.
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Channel Units - Engineering units of the service history analyzed.

TimeSlice - The beginning and ending times for the segment of service history analyzed. Expressed in seconds.

Stress Life Parameters

Mean Stress Model - Stress model used: either the Goodman model, Gerber model, or None (no mean stress
correction). Mean stress correction accounts for the fact that cycles with equivalent amplitudes but higher
mean stresses are more damaging in fatigue.

Notch Factor - Fatigue notch factor value related to the theoretical stress concentration factor of a given notch
geometry. This should be greater than or equal to 1;a value of 1 represents no notch intensification.

Material Properties
Material Name - Brief description of the material whose parameters are defined.

Elastic Modulus - Value indicating the elastic (Young’s) modulus ratio of stress to strain of the material as
determined from a monotonic tensile test.

Ultimate Strength - (Su) Value indicating the ultimate strength of the material - the highest engineering stress
that was reached by a material specimen during a monotonic tensile test.

Curve Intercept - Intercept at 1 cycle on a log-log plot of stress amplitude versus cycles to failure.

Curve Slope - Slope of the straight line from a log-log plot of stress amplitude versus cycles to failure. It should
be a negative number less than 1.

Fat. Limit Cycles - The number of cycles considered to represent infinite life.

Strain Life Fatigue

Strain Life Analysis models actual stress-strain behavior at the critical location in a component. Plastic strains that
may occur infrequently during service loading are accounted for in this analysis. Cycle-dependent material
properties provide a more accurate estimate of the service performance of the material than traditional tensile
test data. Use of strain life method is limited to situations where crack nucleation consumes the majority of the
service life. This is typical of smaller components rather than of full-scale engineering structures.
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To start Strain Life Analysis, select it from the Fatigue Damage sub-menu of the Tools menu, or click the Strain
Life button, ﬂ on the toolbar.

k. Strain Life Fatigue : x|

Channel: Allmodes. zif-TimeHiztE

Farameters
Scale Factor Match Factor
Dretailz
1 1
b aterial Congtant Amplitude
HELLC 20 Steel Mir. Strain Max. Strain
1000 11000
Load ek Plot 22 Plot |
4 Prediction
Export 2k, | Cancel | Analyze |

Strain Life Fatigue Dialog Box

Parameters
Channel - The data file and channel name to analyze.

Parameters

Scale Factor - Multiplier value for the input data. Changing this value illustrates how increasing or decreasing
the amplitude of the service history affects the fatigue life.

Notch Factor - Fatigue notch factor value related to the theoretical stress concentration factor of a given notch
geometry. This should be greater than or equal to 1;a value of 1 represents no notch intensification.

Details - Display a special dialog for specifying all of the parameters of the analysis.

Material
Description of the material properties curves used in this analysis.

Load - Browse the computer file system for an InField Material File (*.MAT) to load. After the file is loaded, the
Details window is opened.

eN Plot - Displays a plot of the strain life curve for the material based on the defined parameters.

se Plot - Displays a plot of the cyclic stress/strain curve for the material based on the defined parameters.
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Constant Amplitude

Min. Strain - The minimum strain (valley) of the constant amplitude strain cycle to be analyzed. It should be in
units strain or microstrain.

Max. Strain - The maximum strain (peak) of the constant amplitude strain cycle to be analyzed. It should be in
units strain or microstrain.

CA Prediction - Predict the number of constant amplitude cycles the component can withstand before failure.
The cycle is defined by the maximum and minimum strains specified above.

Buttons
Help - Open the InField help system to the topic directly related to Strain Life Fatigue Analysis.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be the default.
Cancel - Exit without saving changes or applying any analysis functions.

Analyze - Perform the Strain Life Fatigue Analysis according to the parameters provided. The Strain Life Fatigue
dialog box will remain visible behind the Strain Life Fatigue Report that is generated from the analysis.
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oW StrainLife

Strain Life Fatigue - Details Dialog
This standard properties dialog lets you edit all of the available parameters for Strain Life Analysis.

Bl Geresdl A

Scale Fackar

1

Motch Fackor 1

Damage Model Marrow
Fatigue Limit Cycles 10000000
Motch Rule Meuber
Motch File

Darnage Surm 1

=B General M aterial
Material Marne

Elastic Modulus, E - 29500 T
Shear Madulus, G 12000
Poisson's Ratio 0.3

HRLC 20 Steel

=10l x|

= Tensile Strain Life

SF 76,5

b -0,085

Ef 0.17

C -0.45

g as a1d ﬂ

Strain Life Details Dialog Box

General

Scale Factor- Multiplier value for the input data. Changing this value illustrates how increasing or decreasing the
amplitude of the service history affects the fatigue life.

Notch Factor - Fatigue notch factor value related to the theoretical stress concentration factor of a given notch
geometry. This should be greater than or equal to 1;a value of 1 represents no notch intensification.

Damage Model - Damage (mean stress) model used: either the Marrow model, Smith-\Watson-Topper (SWT),
Epsilon, Gamma, or Fatemi. Mean stress correction accounts for the fact that cycles with equivalent
amplitudes but higher mean stresses are more damaging in fatigue.

Fatigue Limit Cycles - The number of cycles considered to represent infinite life.

Notch Rule - Notch rule used: either Neuber, Neuber (S=Ee), Glinka, Glinka (S=Ee), or Experimental. The
designator, S=Ee, indicates that the nominal behavior is considered to be elastic. If Experimental is selected,
a valid notch file must be specified.

Notch File - Name of file containing a curve of input load versus notch root strain.

Damage Sum - The damage summation in Miner's Law can be set to a number other than 1.0.
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General Material
Material Name - Brief description of the material whose parameters are defined.

Elastic Modulus, E - Value indicating the elastic (Young's) modulus ratio of stress to strain of the material as
determined from a monotonic tensile test.

Shear Modulus, E - Value indicating the elastic (Young's) modulus ratio of stress to strain of the material as
determined from a monotonic torsion test.

Poisson’s Ratio - Poisson's Ratio is defined as the ratio of lateral strain and axial strain in a cylindrical uniaxial
tension specimen. The value for most metals falls between 0.25 to 0.35.The Poisson's Ratio is bounded by
two theoretical limits: it must be greater than -1 and less than or equal to 0.5.

Tensile Strain Life

Sf - The Fatigue Strength Coefficient, Sf, is the intercept at 1 reversal on a log-log plot of stress amplitude versus
reversals to failure.

b - The Fatigue Strength Exponent, b, is the slope of the straight line from a log-log plot of stress amplitude versus
reversals to failure.

Ef - The Fatigue Ductility Coefficient, Ef, is the intercept at 1 reversal on a log-log plot of plastic strain amplitude
versus reversals to failure.

¢ - The Fatigue Ductility Exponent, c, is the slope of a straight line from a log-log plot of plastic strain amplitude
versus reversals to failure.

K’ - The Cyclic Strength Coefficient, K, is the intercept at a plastic strain amplitude of 1 on a log-log plot of stress
amplitude versus plastic strain amplitude.

n’ - The Cyclic Strength Exponent, n', is the slope of the straight line on a log-log plot of stress amplitude versus
plastic strain amplitude.

Shear Strain Life

Tf’ - The Fatigue Strength Coefficient measured in a torsion test.
b0 - The Fatigue Strength Exponent measured in a torsion test.
gf’ - The Fatigue Ductility Coefficient measured in a torsion test.
c0 - The Fatigue Ductility Exponent measured in a torsion test.

K’-90 - The Cyclic Strength Coefficient measured in a torsion test.

Output Options
Cycle Histogram - Add a range versus mean cycle histogram to the results file.
Damage Histogram - Add a range versus mean histogram indicating the damaging cycles to the results file.

Material Properties - Add an XY channel containing a strain amplitude versus life diagram to the results file.
Also, add an XY channel containing a cyclic stress-strain curve to the results file.

Hysteresis Loops - Add an XY channel containing the largest stress-strain hysteresis loops to the results file.
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Exceedance Diagram - Add a cumulative count to the results file of how many times peaks in the data
exceeded a specified level. How long the peaks exceeded the level is not measured. The exceedance diagram
can be either peak-valley or range-pair.

Strain Life Fatigue - Constant Amplitude (CA) Prediction Dialog

Constant amplitude Strain Life Analysis produces the following results table.

«k Constant Amplitu -0 ﬂ

STRAIM LIFE ESTIMATE -
Cycles Ta Failure E.263E+06

hir. Irpowst -1000.00

hfar . Impost 1000.00

STRAIM LIFE PARAMETERS

Damage Model el g gultly
Motch Model Meuber
Scale Factar 1.00
Motch Factar 1.00
STRESSES ARD STRAINS

hla . Maominal Strain 1000
hin. Mominal. Strain -1000
M. Matninal. Stress 26.360
Min. Mominal. Stress -26.360
M. Botch. Strain 1000
hdin. Match. Strain -1000
hax. Motch. Stress 26.360
hlin. Motch. Stress -26.360

MATERIAL PROPERTIES
Material Mame HRLC 20 Steel j

Strain Life Constant Amplitude Prediction Dialog Box

Strain Life Estimate

Cycles to Failure - Number of constant amplitude cycles the component can withstand before failure. The cycle
is defined by the maximum and minimum loads specified below. NOT FATIGUE means the input load
amplitude exceeds the load-life curve intercept. INFINITE means the input load amplitude is less than the
load-life curve value at the fatigue limit cycles.

Min. Input - Minimum strain (valley) of the constant amplitude cycle analyzed.

Max. Input - Maximum strain (peak) of the constant amplitude cycle analyzed.

Fatigue Calculator ¢ page 97



Strain Life Parameters

Damage Model - Damage (mean stress) model used: either the Marrow model, Smith-Watson-Topper (SWT),
Epsilon, Gamma, or Fatemi. Mean stress correction accounts for the fact that cycles with equivalent
amplitudes but higher mean stresses are more damaging in fatigue.

Notch Model - Notch rule used: either Neuber, Neuber (S=Ee), Glinka, Glinka (S=Ee), or Experimental. The
designator, S=Ee, indicates that the nominal behavior is considered to be elastic. If Experimental is selected,
a valid notch file must be specified.

Scale Fator - Multiplier value for the input data. Changing this value illustrates how increasing or decreasing the
amplitude of the service history affects the fatigue life.

Notch Factor - Fatigue notch factor value related to the theoretical stress concentration factor of a given notch
geometry. This should be greater than or equal to 1;a value of 1 represents no notch intensification.

Stresses and Strains

Max. Nominal Strain - Highest strain detected in the nominal stress field.
Min. Nominal Strain - Lowest strain detected in the nominal stress field.
Max. Nominal Stress - Highest stress detected in the nominal stress field.
Min. Nominal Stress - Lowest stress detected in the nominal stress field.
Max. Notch Strain - Highest strain detected in the notch stress field.
Min. Notch Strain - Lowest strain detected in the notch stress field.
Max. Notch Stress - Highest stress detected in the notch stress field.

Min. Notch Stress - Lowest stress detected in the notch stress field.

Material Properties
Material Name - Brief description of the material whose parameters are defined.

Elastic Modulus - Value indicating the elastic (Young's) modulus ratio of stress to strain of the material as
determined from a monotonic tensile test.

Poisson’s Ratio - Poisson's Ratio is defined as the ratio of lateral strain and axial strain in a cylindrical uniaxial
tension specimen. The value for most metals falls between 0.25 to 0.35.The Poisson's Ratio is bounded by
two theoretical limits: it must be greater than -1 and less than or equal to 0.5.

Ultimate Strength - (Su) Value indicating the ultimate strength of the material - the highest engineering stress
that was reached by a material specimen during a monotonic tensile test.

Yield Strength - Value indicating the stress at the onset of yielding as determined from a monotonic tensile test.

Fatigue Strength Coeff, Sf - The intercept at 1 reversal on a log-log plot of stress amplitude versus reversals
to failure.

Fatigue Strength Exp, b - The slope of the straight line from a log-log plot of stress amplitude versus reversals
to failure.

Fatigue Ductility Coeff, Ef - The intercept at 1 reversal on a log-log plot of plastic strain amplitude versus
reversals to failure.
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Fatigue Ductility Exp, ¢ - The slope of a straight line from a log-log plot of plastic strain amplitude versus
reversals to failure.

Cyclic Strength Coeff, K’ - The intercept at a plastic strain amplitude of 1 on a log-log plot of stress amplitude
versus plastic strain amplitude.

Cyclic Strength Exp, n’ - The slope of the straight line on a log-log plot of stress amplitude versus plastic strain
amplitude.

Fatigue Limit Cycles - The number of cycles considered to represent infinite life.

Strain Life Fatigue Report
A successful variable amplitude Strain Life Analysis produces the following results table.

=# Strain Life Report
STRAIM LIFE ESTIMATE

Blocks To Failure IMFIMITE - Motch Data Amplitude of 0.0008E iz smaller than the Strain at the Fatigue Limit of 0.00
Hours Ta Failure M,

hiny. Inpost -990.32

Max. Input Fa8.00

IMPUT CHAMMEL INFORMATICN

Filename: C:WProgram Files\SomMatinField' Examplesiilimodes sif
Channelflame TimeHizt&,

Channel Lakel Strain

Channel Units uE

Timeslice 0.000 to 6385 .556 seconds

STRAIN LIFE PARAMETERS

Damage Madel Marr o
Motch Model Meuber
Sicale Factar 1.00
Motch Factar 1.00

STRESSES AND STRAINS

Maz. Maminal Strain Fag
Min. Motninal. Strain -9an0
Er

Strain Life Report Dialog Box

Strain Life Estimate

Blocks to Failure - Number of repeats of the service history (input channel) the component can withstand
before failure. NOT FATIGUE means the maximum input load amplitude from the service history exceeds
the load-life curve intercept. INFINITE means the maximum input load amplitude from the service history
is less than the load-life curve at the fatigue limit cycles.

Hours to Failure - Number of hours corresponding to the blocks to failure. It equals blocks to failure times the
number of hours in one history repeat.
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Min. Input - Minimum data point in the input service history.

Max. Input - Maximum data point in the input service history.

Input Channel Information

Filename - Path and filename of the service history analyzed.

Channelname - Channel name identifier of the service history analyzed.
Channel Label - Extended channel descriptor of the service history analyzed.
Channel Units- Engineering units of the service history analyzed.

TimeSlice - The beginning and ending times for the segment of service history analyzed. Expressed in seconds.

Strain Life Parameters

Damage Model - Damage (mean stress) model used: either the Marrow model, Smith-Watson-Topper (SWT),
Epsilon, Gamma, or Fatemi. Mean stress correction accounts for the fact that cycles with equivalent
amplitudes but higher mean stresses are more damaging in fatigue.

Notch Model - Notch rule used: either Neuber, Neuber (S=Ee), Glinka, Glinka (S=Ee), or Experimental. The
designator, S=Ee, indicates that the nominal behavior is considered to be elastic. If Experimental is selected,
a valid notch file must be specified.

Scale Factor - Multiplier value for the input data. Changing this value illustrates how increasing or decreasing
the amplitude of the service history affects the fatigue life.

Notch Factor - Fatigue notch factor value related to the theoretical stress concentration factor of a given notch
geometry. This should be greater than or equal to 1;a value of 1 represents no notch intensification.

Stresses and Strains

Max. Nominal Strain - Highest strain detected in the nominal stress field.
Min. Nominal Strain - Lowest strain detected in the nominal stress field.
Max. Nominal Stress - Highest stress detected in the nominal stress field.
Min. Nominal Stress - Lowest stress detected in the nominal stress field.
Max. Notch Strain - Highest strain detected in the notch stress field.
Min. Notch Strain - Lowest strain detected in the notch stress field.
Max. Notch Stress - Highest stress detected in the notch stress field.

Min. Notch Stress - Lowest stress detected in the notch stress field.

Component Properties
Material Name - Brief description of the material whose parameters are defined.

Elastic Modulus - Value indicating the elastic (Young's) modulus ratio of stress to strain of the material as
determined from a monotonic tensile test.
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Poisson’s Ratio - Poisson's Ratio is defined as the ratio of lateral strain and axial strain in a cylindrical uniaxial
tension specimen. The value for most metals falls between 0.25 to 0.35. Poisson's Ratio is bounded by two
theoretical limits: it must be greater than -1 and less than or equal to 0.5.

Ultimate Strength - (Su) Value indicating the ultimate strength of the material - the highest engineering stress
that was reached by a material specimen during a monotonic tensile test.

Yield Strength - Value indicating the stress at the onset of yielding as determined by a monotonic tensile test.

Fatigue Strength Coeff, Sf - The intercept at 1 reversal on a log-log plot of stress amplitude versus reversals
to failure.

Fatigue Strength Exp, b - The slope of the straight line from a log-log plot of stress amplitude versus reversals
to failure.

Fatigue Ductility Coeff, Ef - The intercept at 1 reversal on a log-log plot of plastic strain amplitude versus
reversals to failure.

Fatigue Ductility Exp, ¢ - The slope of a straight line from a log-log plot of plastic strain amplitude versus
reversals to failure.

Cyclic Strength Coeff, K’ - The intercept at a plastic strain amplitude of 1 on a log-log plot of stress amplitude
versus plastic strain amplitude.

Cyclic Strength Exp, n’ - The slope of the straight line on a log-log plot of stress amplitude versus plastic strain
amplitude.

Fatigue Limit Cycles - The number of cycles considered to represent infinite life.
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Weld Life Fatigue

BS5400 Analysis is used for analyzing the welded areas of structures. It uses a series of predefined curves.To pick
the SN curve for a particular problem, you must first classify the weld in accordance with the BS5400 standard.
There are seven weld classes: B, C, D, E, F, F2 and W, where B is the strongest.

To start Weld Life Analysis, select it from the Fatigue Damage sub-menu of Tools menu, or click the Weld Life

%
button, ==ml on the toolbar.

=% Weld Life Fatigue x|
Channel: Allmodes. zif-TimeHistB
Farameters
Scale Factor Dezign Critenion
Detailz
1 1
Weld Clazs Conztant Amplitude
Clazs W Min. Strain Max. Strain
1000 11000
Load | Save |

.................. C4 Prediction |

S
Help | Export | 0k, | Cancel | Analyze |

Weld Life Fatigue Dialog Box

Parameters
Channel - The data file and channel name to analyze.

Parameters

Scale Factor - Multiplier value for the input data. Changing this value illustrates how increasing or decreasing
the amplitude of the service history affects fatigue life. The default value is 1.

Design Criterion - Design Criterion is related to the probability of failure and is expressed as the number of
Standard Deviations. A value of 0 represents a 50% failure rate, 1 represents 15.9%, 3 represents 2.2%, etc.

Details - Display a special dialog for specifying all of the parameters for the analysis.

Weld Class
Description of the BS5400 Weld Class used in this analysis.
Load - Browse the computer file system for an InField Weld Class File (*.WLD) to load.

Save - Create an InField Weld Class file (*.WLD).
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sN Plot - Display a plot of the stress-life curve for the chosen weld class based on the defined parameters.

Constant Amplitude

Min. Strain - The minimum strain (valley) of the constant amplitude strain cycle to be analyzed. It should be in
units strain or microstrain.

Max. Strain - The maximum strain (peak) of the constant amplitude strain cycle to be analyzed. It should be in
units strain or microstrain.

CA Prediction - Predict the number of constant amplitude cycles the component can withstand before failure.
The cycle is defined by the maximum and minimum strains specified above.

Buttons
Help - Open the InField help system to the topic directly related to Weld Life Fatigue Analysis.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be the default.
Cancel - Exit without saving changes or applying any analysis functions.

Analyze - Perform the Weld Life Fatigue analysis according to the parameters provided. The Weld Life Fatigue
dialog box will remain visible behind the Weld Life Fatigue Report that is generated from the analysis.
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Weld Life Fatigue - Details Dialog

This standard properties dialog lets you edit all of the available parameters for Weld Life Analysis.

=% WeldLife - 0| x|
Bl General
Scale Fackaor 1
De=ign Criterion 1
Skress Units MPA
B  Weld Class Properties
weld Mame Class W

Elastic Modulus, E - 207000
Ultimate Strength 500
Skress AF 1 Cycle 7179

Curve Slope 3

S0 Modifier 0.654
=B Output Options

Cyrle Hiskogram False

Ciamage Histogram  False
Material Properties  False
Exceedance Diagram False

Weld Life Details Dialog Box

General

Scale Factor - Multiplier value for the input data. Changing this value illustrates how increasing or decreasing
the amplitude of the service history affects fatigue life. The default value is 1.

Design Criterion - Design Criterion is related to the probability of failure and is expressed as the number of
Standard Deviations. A value of 0 represents a 50% failure rate, 1 represents 15.9%, 3 represents 2.2%, etc.

Stress Units - Units for the SN curve of the selected weld class. Either Mpa or Ksi.

Weld Class Properties
Weld Name - Description of the Weld Class.

Elastic Modulus, E - Value indicating the elastic (Young's) modulus ratio of stress to strain of the material as
determined from a monotonic tensile test. This value should be in the same units as those in the Stress
Units field.
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Ultimate Strength - (Su) Value indicating the ultimate strength of the material - the highest engineering stress
that was reached by a material specimen during a monotonic tensile test. This value should be in the same
units as those in the Stress Units field.

Stress at 1 Cycle - Theoretical Stress Range at 1 cycle of a log-log plot if stress range versus cycles to failure is
extended back.

Curve Slope - Slope of the straight line from a log-log plot of stress range versus cycles to failure. It is generally
3 or 4 for weld classes.

SD Modifier - Standard Deviation Modifier defined for the Weld Class.

Output Options
Cycle Histogram - Add a range versus mean cycle histogram to the results file.
Damage Histogram - Add a range versus mean histogram indicating the damaging cycles to the results file.

Material Properties - Add an XY channel containing a stress amplitude versus life diagram of the Weld Class
to the results file.

Exceedance Diagram - Add a cumulative count to the results file of how many times peaks in the data
exceeded a specified level. How long the peaks exceed the level is not measured. The exceedance diagram
can be either peak-valley or range-pair.

Weld Life Fatigue - Constant Amplitude (CA) Prediction Dialog

Constant amplitude Weld Life Analysis produces the following results table.

RI=E3

WELD LIFE ESTIMATE

Cycles To Failure 5214
hir. Impost -1000.00
hax. Input 1000.00

WELD COMPONENT PROPERTIES

Wield Class Clazs W
Elastic Modulus 207000
Uttimate Strencgth s00

S Intercept at 1 Cycle 717an
S Slope 3.00
Stdl. Dew. Modifier 0.654
Des=ign Criterion 1.000

Weld Life Constant Amplitude Prediction Dialog Box
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Weld Life Estimate

Cycles to Failure - Number of constant amplitude cycles the component can withstand before failure.The cycle
is defined by the maximum and minimum loads specified below. NOT FATIGUE means the input load
amplitude exceeds the load-life curve intercept. INFINITE means the input load amplitude is less than the
load-life curve value at the fatigue limit cycles.

Min. Input - Minimum strain (valley) of the constant amplitude cycle analyzed.

Max. Input - Maximum strain (peak) of the constant amplitude cycle analyzed.

Weld Component Properties
Weld Class - Weld Class used in this life prediction.

Elastic Modulus - Value indicating the elastic (Young's) modulus ratio of stress to strain of the material as
determined from a monotonic tensile test.

Ultimate Strength - (Su) Value indicating the ultimate strength of the material - the highest engineering stress
that was reached by a material specimen during a monotonic tensile test.

SN Intercept at 1 Cycle - SN Intercept at 1 cycle of the Weld Class used in this life prediction.

SN Slope - Slope of the straight line from a log-log plot of stress range versus cycles to failure. It is generally 3
or 4 for weld classes.

Std. Dev. Modifier - Standard Deviation Modifier defined for the Weld Class.

Design Criterion - Design Criterion is related to the probability of failure and is expressed as the nhumber of
Standard Deviations. A value of O represents a 50% failure rate, 1 represents 15.9%, 3 represents 2.2%, etc.
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Weld Life Fatigue Report

A successful variable amplitude Weld Life Analysis produces the following results table.

uh- Weld Life Repork

=10 %

WELD LIFE ESTIMATE

Blocks To Failure
Hours Ta Failure
Min. Inpt
Mz, Input

IMPUT CHARNMEL IMFORMATION
Filename

Channelame

Channel Lakbel

Channel Units

TimeSlice

WELD COMPOMENT PROPERTIES
Wield Class

Elastic Modulus

Litirmate Strendth

SN Intercept at 1 Cycle

SM Slope

Std. Dev. Modifier

Design Criterion

ar.n02
1045
-990.52
3500

COProgram Files\SobatnField' Examples\alimodes zif
TimeHista,

Strain

uE

0.000 to 6595 556 seconds

Clasz W
207000
00
TTran
3.00
0.E54
1.000

Weld Life Estimate

Weld Life Report Dialog Box

Blocks to Failure - Number of repeats of the service history (input channel) the component can withstand
before failure. NOT FATIGUE means the maximum input load amplitude from the service history exceeds
the load-life curve intercept. INFINITE means the maximum input load amplitude from the service history
is less than the load-life curve value at the fatigue limit cycles.

Hours to Failure - Number of hours corresponding to the blocks to failure. It is blocks to failure times the

number of hours in one history repeat.

Min. Input - Minimum data point in the input service history.

Max. Input - Maximum data point in the input service history.
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Input Channel Information

Filename - Path and filename of the service history analyzed.
ChannelName - Channel name identifier of the service history analyzed.
Channel Label - Extended channel descriptor of the service history analyzed.
Channel Units - Engineering units of the service history analyzed.

TimeSlice - The beginning and ending times for the segment of service history analyzed. Expressed in seconds.

Weld Component Properties
Weld Class - Weld Class used in this life prediction.

Elastic Modulus - Value indicating the elastic (Young's) modulus ratio of stress to strain of the material as
determined from a monotonic tensile test.

Ultimate Strength - (Su) Value indicating the ultimate strength of the material - the highest engineering stress
that was reached by a material specimen during a monotonic tensile test.

SN Intercept at 1 Cycle - SN Intercept at 1 cycle of the Weld Class used in this life prediction.

SN Slope - Slope of the straight line from a log-log plot of stress range versus cycles to failure. It is generally 3
or 4 for weld classes.

Std. Dev. Modifier - Standard Deviation Modifier defined for the Weld Class.

Design Criterion - Design Criterion is related to the probability of failure and is expressed as the nhumber of
Standard Deviations. A value of O represents a 50% failure rate, 1 represents 15.9%, 3 represents 2.2%, etc.

Fatigue Calculator « page 108



Crack Growth Fatigue

Crack Growth Analysis uses linear elastic fracture mechanics and related crack growth material properties to
determine how fast a crack or crack-like defect will spread under service loading conditions. This analysis in turn
provides an estimate of the remaining safe life of the structure or component.

To start Crack Growth Analysis, select it from the Fatigue Damage sub-menu of the Tools menu, or click the Crack

Growth button, AN , on the toolbar.

o Crack Growth Fatigue x|
Channel: Allmodes. zif-TimeHistB
Parameters
Scale Factor Irit. Crack. Length
1 0o Dietailz
Crack Geometry
| 1 - Edge cracked plate in tension ﬂ
M atenal Conztant Amplitude
||_||:;|_|: o0 Stesl Mir. Strain Max. Strain
1000 11000
Load | dac Pl
C& Prediction
Expart | ()% | Carnicel | Analyze |

Crack Growth Fatigue Dialog Box

Parameters
Channel - The data file and channel name to analyze.

Parameters

Scale Factor - Multiplier value for the input data. Changing this value illustrates how increasing or decreasing
the amplitude of the service history affects the fatigue life.

Init. Crack Length - The assumed initial size of an existing crack whose growth is to be modeled.
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Crack Geometry - A description of the object to be modeled. If USER STRESS INTENSITY FILE is selected, a
valid crack geometry file must be specified in the parameter details.

Available options are:

1 - Edge cracked plate in tension

2 - Edge cracked plate in bending

3 - Double edge cracked plate in tension

4 - Double edge cracked plate in bending

5 - Center cracked plate in tension

6 - Center cracked plate in bending

7 - Center cracked rod in tension

8 - Center cracked rod in bending

9 - Center cracked rod in torsion

10 - Edge cracked rod in tension

11 - Edge cracked rod in bending

12 - Edge cracked rod in torsion

13 - Hole - Center edge crack in tension

14 - Hole - Center dbl edge crack in tension (R=.5h)
15 - Hole - Center dbl edge crack in tension (R=.25b)
16 - Corner crack

17 - SAE keyhole specimen

18 - Shallow notch - edge crack in tension (1)
19 - Shallow notch - edge crack in tension (2)
20 - Rectangular tube in bending

21 - Double butt weld - toe crack in tension
22 - Double butt weld - toe crack in bending
23 - Surf crack unwelded in tension (a/2c=.1)
24 - Surf crack unwelded in tension (a/2c=.5)
25 - Surf crk dbl fillet weld - tension (a/2c=.1)
26 - Surf crk dbl fillet weld - tension (a/2c=.5)
27 - Dbl fillet weld - toe crack in bending

28 - Dbl fillet weld - root crack in tension

29 - Dbl fillet weld - root crack in bending

30 - One side lap weld - root crack in tension
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31 - One side lap weld - root crack in bending
32 - Surf crack in tension (a/c=1-.2(a/b)"2)

33 - Edge crack in tension without bending
USER STRESS INTENSITY FILE

Details - Display a special dialog for specifying all of the parameters for the analysis.

Material
Description of the material properties curves used in this analysis.

Load - Browse the computer file system for an InField Material File (*.MAT) to load. After the file is loaded, the
Details window is opened.

da/dN Plot - Display a plot of the crack growth rate, da/dN, versus stress intensity, delta-K, for the material based
on the defined parameters.

Constant Amplitude

Min. Strain - The minimum strain (valley) of the constant amplitude strain cycle to be analyzed. It should be in
units strain or microstrain.

Max. Strain - The maximum strain (peak) of the constant amplitude strain cycle to be analyzed. It should be in
units strain or microstrain.

CA Prediction - Predict the number of constant amplitude cycles the component can withstand before failure.
The cycle is defined by the maximum and minimum strains specified above.

Buttons
Help - Open the InField help system to the topic directly related to Crack Growth Fatigue Analysis.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be the default.
Cancel - Exit without saving changes or applying any analysis functions.

Analyze - Perform the Crack Growth Fatigue analysis according to the parameters provided. The Crack Growth
Fatigue dialog box will remain visible behind the Crack Growth Fatigue Report that is generated from the
analysis.
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ol CrackGrowth

Bl Genead N

Crack Growth Fatigue - Details Dialog
This standard properties dialog lets you edit all of the available parameters for Crack Growth Analysis.

=10 x|

Scale Fackor 1
=B Crack Geometry
Crack Geometry 1 - Edge cracked plate in ten
IUser 3.1, File
Clasure Madel Mone
Percent Closure 0
Initial Crack Lenath .01
Final Crack Length 7.5
Plake width 10
Mokch Depth 10
Mokch Tip Radius 10
B Material Properties ]
Elastic Modulus, E 29500
Yield Strength, Sw 50
Paris Law Intercept 2e-009
Paris Law Exponent 343
Threshold Stress Intensity 5
i“rikimal Shrace TRbamcibu ':III 2N ﬂ

Crack Growth Details Dialog Box

General

Scale Factor - Multiplier value for the input data. Changing this value illustrates how increasing or decreasing
the amplitude of the service history affects the fatigue life.

Crack Geometry

Crack Geometry - A description of the object model. If USER STRESS INTENSITY FILE is selected, a valid crack
geometry file must be specified.

User S.1. File - Name of the file containing a valid stress intensity geometry file. Required if Crack Geometry
choice is USER STRESS INTENSITY FILE.

Closure Model - The analytical model which accounts for crack closure effect.
Closure at percentage of max. stress
Closure calculated from service history

None
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Percent Closure - The value in percent used by the closure model.
Initial Crack Length - The assumed initial size of an existing crack whose growth is to be modeled.

Final Crack Length - The assumed final size of a crack whose growth is to be modeled. This analysis predicts
the time required for the crack to grow from initial to final size.

Plate Width - The width of the cracked object being modeled.
Notch Depth - The notch depth of the cracked object being modeled.
Notch Tip Radius - The notch tip radius of the cracked object being modeled.

Material Properties

Elastic Modulus, E - Value indicating the elastic (Young's) modulus ratio of stress to strain of the material as
determined from a monotonic tensile test. This value should be in the same stress units as the da/dN (Paris
Law) material properties.

Yield Strength, Sy - Value indicating the stress at the onset of yielding as determined from a monotonic tensile
test. This value should be in the same stress units as the da/dN (Paris Law) material properties.

Paris Law Intercept - Intercept at a stress intensity of 1 on a log-log plot of crack growth rate versus stress
intensity.

Paris Law Exponent - Slope of the straight line from a log-log plot of crack growth rate versus stress intensity.
It should be a positive number around 3 for steels.

Threshold Stress Intensity -Value indicating the minimum stress intensity required for crack growth.This value
should be in the same stress intensity units as the da/dN (Paris Law) material properties.

Critical Stress Intensity - Value indicating the minimum stress intensity required for unstable crack growth.
This value should be in the same stress intensity units as the da/dN (Paris Law) material properties.

Ratio of Matl Prop - The stress ratio, Smin/Smax, for which the da/dN (Paris Law) material properties were
determined.

Output Options
Cycle Histogram - Add a range versus mean cycle histogram to the results file.
Damage Histogram - Add a range versus mean histogram indicating the damaging cycles to the results file.

Material Properties - Add an XY channel containing a crack growth rate versus stress intensity curve to the
results file.

Exceedance Diagram - Add a cumulative count to the results file of how many times peaks in the data
exceeded a specified level. How long the peaks exceed the level is not measured. The exceedance diagram
can be either peak-valley or range-pair.
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Crack Growth Fatigue - Constant Amplitude (CA) Prediction Dialog
Constant amplitude Crack Growth Analysis produces the following results table.

ok Constant Amplitude Crack Eru_": o =] 5
CRACK GROWTH ESTIMATE

Cyiles Ta Failure 2279

in. Irpost -1000.00

. Input 1000.00

CRACK GROWTH PARAMETERS

Initial Crack Size 0.01000

Final Crack Size 7.50000

Geometry

Closure Model

MATERIAL PROPERTIES

1 - Edge cracked plate intension

haterial Mame HRELC 20 Steel
Elaztic Modulus 29500
Uttinate Strength

Yield Strength a0

Patis Law Intercept 3.0E-09

Patis Lawy Exponent 3430
Threshold Stress Intensity 5.000

Critical Stress Intensity 20,000

Crack Growth Constant Amplitude Prediction Dialog Box

Crack Growth Estimate

Cycles to Failure - Number of constant amplitude cycles the component can withstand before failure. The cycle
is defined by the maximum and minimum loads specified below. NOT FATIGUE means the input load
amplitude exceeds the load-life curve intercept. INFINITE means the input load amplitude is less than the
load-life curve value at the fatigue limit cycles.

Min. Input - Minimum strain (valley) of the constant amplitude cycle analyzed.

Max. Input - Maximum strain (peak) of the constant amplitude cycle analyzed.

Crack Growth Parameters
Initial Crack Size - The assumed initial size of an existing crack whose growth is to be modeled.

Final Crack Size - The assumed final size of a crack whose growth is to be modeled. This analysis predicts the
time required for the crack to grow from initial to final size.

Geometry - Description of the object modeled.

Closure Model - The analytical model which accounts for crack closure effect.
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Material Properties
Material Name - Description of the material whose parameters are defined

Elastic Modulus - Value indicating the elastic (Young's) modulus ratio of stress to strain of the material as
determined from a monotonic tensile test. This value should be in the same stress units as the da/dN (Paris
Law) material properties.

Ultimate Strength - (Su) Value indicating the ultimate strength of the material - the highest engineering stress
that was reached by a material specimen during a monotonic tensile test.

Yield Strength - Value indicating the stress at the onset of yielding as determined from a monotonic tensile test.
This value should be in the same stress units as the da/dN (Paris Law) material properties.

Paris Law Intercept - Intercept at a stress intensity of 1 on a log-log plot of crack growth rate versus stress
intensity.

Paris Law Exponent - Slope of the straight line from a log-log plot of crack growth rate versus stress intensity.
It should be a positive number around 3 for steels.

Threshold Stress Intensity - Value indicating the minimum stress intensity required for crack growth. This value
should be in the same stress intensity units as the da/dN (Paris Law) material properties.

Critical Stress Intensity - Value indicating the minimum stress intensity required for unstable crack growth.
This value should be in the same stress intensity units as the da/dN (Paris Law) material properties.
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Crack Growth Fatigue Report
A successful variable amplitude Crack Growth Analysis produces the following results table.

al Crack Growth Report

-10] x|

CRACK GROWTH ESTIMATE

Blocks Ta Failure
Hours To Failure
hin. Input
fla. Input

IMPUT CHARMEL IMFORRMATICN
Filename

ChannelMame

Channel Lakel

Channel Units

TimesSlice

CRACK GROWTH PARAMETERS
Initial Crack Size

Final Crack Size

Geametry

Clazure Maodel

MATERIAL PROPERTIES
haterial Mame
Elastic Modulus

B

IMFIMITE
M2,
-995.00
338.23

CProgram Files'SobMatinField Examples\limodes sif
TimeHiztB

Strain

uE

0.000 to 2754 444 zeconds

0.01000
750000
1 - Edge cracked plate in tengion

HRLC 20 Steel
23500

s

Crack Growth Estimate

Crack Growth Report Dialog Box

Blocks to Failure - Number of repeats of the service history (input channel) the component can withstand
before failure. NOT FATIGUE means the maximum load amplitude from the service history exceeds the
load-life curve intercept. INFINITE means the maximum input load amplitude from the service history is

less than the load-life curve value at the fatigue limit cycles.

Hours to Failure - Number of hours corresponding to the blocks to failure. It equals blocks to failure times the

number of hours in one history repeat.

Min. Input - Minimum data point in the input service history.

Max. Input- Maximum data point in the input service history.

Input Channel Information

Filename - Path and filename of the service history analyzed.

ChannelName - Channel name identifier of the service history analyzed.

Channel Label - Extended channel descriptor of the service history analyzed.
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Channel Units - Engineering units of the service history analyzed.

TimeSlice - The beginning and ending times for the segment of service history analyzed. Expressed in seconds.

Crack Growth Parameters
Initial Crack Size - The assumed initial size of an existing crack whose growth is to be modeled.

Final Crack Size - The assumed final size of a crack whose growth is to be modeled. This analysis predicts the
time required for the crack to grow from initial to final size.

Geometry - Description of the object modeled.

Closure Model - The analytical model which accounts for crack closure effect.

Material Properties
Material Name - Brief description of the material whose parameters are defined.

Elastic Modulus - Value indicating the elastic (Young's) modulus ratio of stress to strain of the material as
determined from a monotonic tensile test. This value should be in the same stress units as the da/dN (Paris
Law) material properties.

Ultimate Strength - (Su) Value indicating the ultimate strength of the material - the highest engineering stress
that was reached by a material specimen during a monotonic tensile test.

Yield Strength -Value indicating the stress at the onset of yielding as determined from a monotonic tensile test.
This value should be in the same stress units as the da/dN (Paris Law) material properties.

Paris Law Intercept - Intercept at a stress intensity of 1 on a log-log plot of crack growth rate versus stress
intensity.

Paris Law Exponent - Slope of the straight line from a log-log plot of crack growth rate versus stress intensity.
It should be a positive number around 3 for steels.

Threshold Stress Intensity -Value indicating the minimum stress intensity required for crack growth.This value
should be in the same stress intensity units as the da/dN (Paris Law) material properties.

Critical Stress Intensity - Value indicating the minimum stress intensity required for unstable crack growth.
This value should be in the same stress intensity units as the da/dN (Paris Law) material properties.
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Material Properties
To start Material Properties Editor, select it from the Fatigue Damage sub-menu of the Tools menu.

=% Material Property Editor E o [=] EH
Name Material Type | eN? | gN? | sN? | dasdN? | =
1100 Alurminunm #
2M4-H Alurminunm s
2Mm4-14 Alurminunm s
2M4-TE Alurminunm s
2M4-TE Alurminunm s
2M4-TE Alurminunm s
2024-0 Alurminunm s
2024-T3 Alurminunm s
2024-T3 Alurminunm s
2024-T3 Alurminunm s
2024-T351 Alurminunm s
2024-T351 Alurminunm s
2024-T4 Alurirum 5 -
Parameters
b atenal
1100 | Details
N Plot | [F5eFiot | i Pl |
Help Expart [ rpart k. Cancel

Material Property Editor Dialog Box
Parameters

Spreadsheet Information
Name - The material name for which properties are available.
Material Type- The material type for which properties are available.

eN? - An X in this column indicates there is sufficient information about this material to perform aTensile Strain
Life Fatigue Analysis.

gN? - An X in this column indicates there is sufficient information about this material to perform a Shear Strain
Fatigue Analysis.

sN? - An X in this column indicates there is sufficient information about this material to perform a Stress Fatigue
Analysis.

dA/dN? - An X in this column indicates there is sufficient information about this material to perform a Crack
Growth Fatigue Analysis.
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Parameters

Material - Brief description of the material whose properties are defined.

eN Plot - Display a plot of the strain life curve for the material based on the defined parameters.

se Plot - Display a plot of the cyclic stress/strain curve for the material based on the defined parameters.

da/dN Plot - Display a plot of the crack growth rate, da/dN, versus stress intensity, delta-K, for the material based
on the defined parameters.

Details - Display a special dialog for specifying all of the parameters for the material selected.

Buttons
Help - Open the InField help system to the topic directly related to the Material Properties dialog.

Export - Save the information entered directly to an InField Material File (* .MAT).This makes it possible to easily
load the properties into a future session.

Import - Open an InField Material File (*.MAT) for use.
OK - Save the information entered for future use. These parameters will then be the default.

Cancel - Exit without saving changes or applying any analysis functions.
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Frequency Analysis

Analysis Procedure
The procedure for performing a frequency analysis is as follows:

NOTE:  Frequency Analysis dialog boxes are modeless. Clicking outside of a Frequency Analysis dialog
box will allow the use of other windows and functions in the open InField session. Click on
the related dialog to return to the Frequency Analysis.

1. Select the channel(s) to be analyzed from the InField Channels List.
2. Open the dialog box for the analysis to use and set its parameters.
3. Click Analyze to run the analysis according to the parameters entered.

When the analysis is complete, InField will plot the results, add the output channel to the Output List, and create
an output file in the InField installation Output Files directory.

The title bar of each plot window will have the name of the analysis and the name of the channel being validated.

The default file name for the analysis file containing output channels is made up of the function name and analysis
sequence number with a - SI1F extension (SoMat Information File). Sequences start at 000. The sequence number
is determined by the previously created output files for the selected function that exist in the InField installation
Output Files directory.The next available sequence number is used for the newly created file and plot. For example,
if there are existing files titled AutoPower_000.sif and AutoPower_001.sif, selecting the Analyze button
within a AutoPower Spectrum dialog will create a file titled AutoPower_002._sif.

NOTE: Files created in the Output Files directory of the InField installation are not deleted when
InField is exited. Periodic, manual deletion of unnecessary files in this directory is strongly
recommended to conserve disk space on the computer.

4.  Examine the analysis results. Channel plot data can be viewed, edited, copied, and pasted using the functions
described in Viewing Data and Editing Data.

5. Review the Output List. Save the channels to keep, and remove the channels to be discarded.

« To save output channels to a file (other than the default), select them and use SaveAs in the InField File
menu. The saved files will appear in the Output List with the file name specified during the save. The
original, temporary channels can be removed from the Output List.

» To remove channels from the Output list, select the channel(s) to remove then right-click. Use the option
Remove Channel(s) from Channel List to remove the unwanted channels. It is not necessary to
remove the channels from the Output List. This is really just a way to keep the list manageable and avoid
clutter when analyzing data.
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AutoPower Spectrum Analysis

AutoPower Spectrum Analysis is used to investigate the frequency content of measured signals, displacements,
loads, strains, velocities, acceleration, sound pressure, etc. The methodology reduces large time histories into a
smaller amount of information.

Data Analyzed

The AutoPower Spectrum Analysis accepts only time history data. If any other type of data is selected, the
Frequency Analysis will not operate.

To start the AutoPower Spectrum Analysis, either select it from the Frequency Analysis sub-menu of the Tools

menu, or click the AutoPower Spectrum Analysis button, ﬂ on the application toolbar.

:'_H-Frequency Analysis ﬂ
Parameters M i
Elocksize |1 000 ﬂ Frequercy O
Elxlferlap |33 ﬂ Erzlut:iencv 0.1
Windaow |Hanning ﬂ
- Spectum Tepe / Units
Weighting |N|:|ne ﬂ : s
Average Type |Stal:u|e ﬂ Linear Tl [ BMs
Integ / Diff. |N|:|ne ﬂ 1 dB Reference
Help | Expart | k. Cancel | Analuze |

AutoPower Spectrum Analysis Dialog Box

Parameters

Block size - The size of the time block to be used in the computation. The maximum size is limited by either the
size of the time history selected or the memory installed and available to the computer.

Overlap - The amount of data used from the previous time history slice (specified in percentages from 0% to
99%). A block size of 1000 and an overlap of 25% will use 250 points from the previous time block and
include them with the next 750 points in the time history to compute the next spectrum.
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Window - The type of time domain window to be used to weight the time block of data before it is transformed.

Uniform - Using Uniform is essentially the same as not using a window at all. Amplitude accuracy can be
affected by as much as 36%.This window is only useful when an integer number of periods of the time
waveform is included in the time block.

Hanning - Hanning is useful for resolving closely-spaced frequencies where amplitude accuracy (18%) is
not important.

Hamming - Hamming is useful for searching operations where good frequency resolution is needed, but
accuracy of amplitude (15%) is not important. It is particularly useful when a large dynamic range
between spectral lines occurs.

Flat Top - Ideal for accurate amplitude measurements (+/- 0.1%) of spectral lines that are not closely
spaced (8-10 lines) or where a large dynamic range is needed.

Weighting - Used in rescaling the spectrum so it conforms to the sensitivity of the human ear. A, B, and C
weighting are supported.

Average Type - The following types are available:
Stable - Computes the average value observed at a given spectral line per FFT taken.
Peak Hold - Retains the largest value observed at a given spectral line for each FFT taken.
NOTE: Peak hold is not truly an averaging method.

Integration/Differentiation - Besides the option of none, there are four options to select from. The options
and the formulas are:

Differentiate Once - S(w) x (w)
Differentiate Twice - S(w) x (w 2)
Integrate Once - S(w) x (l/w)
Integrate Twice - S(w) x (I/(w?))

where S(w) is the spectrum and w is the angular frequency expressed in radians/second (w =fx2xmw, where
f is frequency expressed in Hz). This is a stable computation in the frequency domain. For
integration, S(w)=0 when w =0.

Spectrum Type/Units

The following parameters are selectable from the drop-down list to control the units of the resulting spectrums:
Linear - EU
Power - EU?
PSD (Power Spectral Density) - EU2/Hz
ESD (Energy Spectral Density - EU? (sec)/Hz, where EU is engineering units

RMS - A method to store the data in Root Mean Square format (EU RMS, EU2 RMS, etc.). RMS is computed using:
Linear - Spectral Line Value/Sqrt(2)
Power - PSD, ESD: Spectral Line Value/2
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dB Reference - A number can be entered as the dB reference. The units must be in the time history's native
units (e.g.\Volts).

Decibels = 20 log10 (S(w)/dbRef) or 10 log10(S(w)/dbRef2), depending on the units of S(w), where S(w) is
the spectrum

Buttons
Help - Open the InField help system to the topic directly related to AutoPower Spectrum Analysis.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be the default.
Cancel - Exit without making any changes or applying any analysis functions.

Analyze - Perform the analysis according to the parameters selected. The Frequency Analysis dialog will remain
visible behind the plot window that is generated by the analysis. The analysis will also generate and add a
data channel to the Output List tab in the Channels List window.

FRF (Frequency Response Function) Analysis

Frequency Response Function (FRF) Analysis is used to evaluate the relationship between channels in the
frequency domain. Outputs may include autopower, crosspower, coherence, and frequency response.

FRF Analysis accepts only time history data. Two channels must be selected before starting the analysis (the
Reference and the Response channels.) Typically the data was acquired simultaneously.

To start FRF Analysis either select it from the Frequency Analysis sub-menu in the Tools menu, or click the

Frequency Response Analysis button, IH_l on the application toolbar.

ﬁFrequency Response Analysis : ﬂ

Reference: Allmodes. zif-3d_Histd,
Rezponze:

Parameters

Blocksize T - baw. Frequency: 0004

Owverlap |33 ﬂ Delka Frequency:  0.000003

WWindaw |Hanning ﬂ

‘weighting |N|:|ne ﬂ Save AutoPowers

I i Save Crozs Power

el i |N':'”E ﬂ Save Coherence

dB Reference |-| Save Freguency Responze [FRF)

Save Operating Deflection Shape [DD5] ...

Help | Expaort | 0k, Cancel | Analyze |

FRF (Frequency Response Function) Dialog Box
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Parameters

Blocksize - The size of the time block to be used in the computation. The maximum size is limited by either the
size of the time history selected or the memory installed and available to the computer.

Overlap - The amount of data used from the previous time history slice (specified in percentages from 0% to
99%). A block size of 1000 and an overlap of 25% will use 250 points from the previous time block and
include them with the next 750 points in the time history to compute the next spectrum.

Window - The type of time domain window to be used to weight the time block of data before it is transformed.

Uniform - Using Uniform is essentially the same as not using a window at all. Amplitude accuracy can be
affected by as much as 36%.This window is only useful when an integer number of periods of the time
waveform is included in the time block.

Hanning - Hanning is useful for resolving closely-spaced frequencies where amplitude accuracy (18%) is
not important.

Hamming - Hamming is useful for searching operations where good frequency resolution is needed, but
accuracy of amplitude (15%) is not important. It is particularly useful when a large dynamic range
between spectral lines occurs.

Flat Top - Ideal for accurate amplitude measurements (+/- 0.1%) of spectral lines that are not closely
spaced (8-10 lines) or where a large dynamic range is needed.

Weighting - Used in rescaling the spectrum so it conforms to the sensitivity of the human ear. A, B, and C
weighting are supported.

Integration/Differentiation - Besides the option of none, there are four options to select from.The options
and the formulas are:

Differentiate Once - S(w) x (w)
Differentiate Twice - S(w) x (w 2)
Integrate Once - S(w) x (I/w)
Integrate Twice - S(w) x (I/(w?))

where S(w) is the spectrum and w is the angular frequency expressed in radians/second (w =f x2xm, where
f is frequency expressed in Hz). This is a stable computation in the frequency domain. For
integration, S(w)=0 when w =0.

dB Reference - A number can be entered as the dB reference. The units must be in the time history's native
units (e.g.Volts).

Decibels = 20 log10 (S(w)/dbRef) or 10 log10(S(w)/dbRef2), depending on the units of S(w), where S(w) is
the spectrum

Max Frequency - The maximum frequency for which values are computed.

Delta Frequency - Resolution or spacing between spectral data points. This value is based on the Nyquist
frequency and equals the sample rate divided by 2.
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Output Options - Multiple output channels can be generated and placed in the Output List tab of the Channels
List window. A check in the checkbox preceeding each option indicates that output data should be
generated upon analysis.

Save AutoPowers

Save Cross Power

Save Coherence

Save Frequency Response (FRF)
Save Operating Deflection Shape

Buttons
Help - Open the InField help system to the topic directly related to Frequency Response Function Analysis.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be the default.
Cancel - Exit without making any changes or applying any analysis functions.

Analyze - Perform the Frequency Responce Function (FRF) analysis according to the parameters provided. The
Frequency Responce Function window will remain visible behind the graphs generated from the analysis. In
addition, new channels will be generated under the Output List tab in the Channels List window.

FFT (Fast Fourier Transform) Analysis

FFT (Fast Fourier Transform) Analysis provides a mathematical method to view the input data in the frequency
domain, amplitude versus frequency, rather than the time domain, amplitude versus time.

To start FFT Analysis select it from the Frequency Analysis sub-menu of the Tools menu, or click the FFT Analysis

button, ﬂ on the application toolbar.

=k FFT Analysis ﬂ
i o | rifarm b

FFT Size: 16
b airnum Frequency 0.0045
Delka Freguency 0.00025

Help | E:-:pn:nrt| (] % Eann::el| gnal_l,lze|

FFT Analysis Dialog Box
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Parameters
Window - The type of time domain window to be used to weight the time block of data before it is transformed.

Uniform - Using Uniform is essentially the same as not using a window at all. Amplitude accuracy can be
affected by as much as 36%.This window is only useful when an integer number of periods of the time
waveform is included in the time block.

Hanning - Hanning is useful for resolving closely-spaced frequencies where amplitude accuracy (18%) is
not important.

Hamming - Hamming is useful for searching operations where good frequency resolution is needed, but
accuracy of amplitude (15%) is not important. It is particularly useful when a large dynamic range
between spectral lines occurs.

Flat Top - Ideal for accurate amplitude measurements (+/- 0.1%) of spectral lines that are not closely
spaced (8-10 lines) or where a large dynamic range is needed.

FFT Size - The number of data points for which a value is computed.
Maximum Frequency - The maximum frequency for which values are computed.

Delta Frequency - Resolution or spacing between spectral data points. This value is based on the Nyquist
frequency and equals the sample rate divided by 2.

Buttons
Help - Open the InField help system to the topic directly related to FFT Analysis.

Export - Save the information entered directly to an analysis script (*. ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use.
Cancel - Exit the FFT Analysis without making any changes or applying any analysis functions.

Analyze - Perform the FFT Analysis according to the parameters selected. The FFT Analysis window will remain
visible behind the graph that is generated from the analysis. In addition, the FFT Analysis will generate a new
channel under the Output List Tab in the Channels List window.
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Inverse FFT (Fast Fourier Transform) Analysis

Inverse FFT (Fast Fourier Transform) provides a mathematical method to view the input data in the time domain,
amplitude versus time, rather than in the frequency domain, amplitude versus frequency.

Inverse FFT (Fast Fourier Transform) requires the selection of exactly two (2) channels, the real and imaginary
computed channels generated from a previously performed FFT analysis.

To start Inverse FFT Analysis select it from the Frequency Analysis sub-menu of the Tools menu, or click the

Inverse FFT button, Iﬂl on the application toolbar.

nk Inverse FFT Analysis X

FFT Size: 29681
b airnum Frequency J297.7748
Delka Freguency h.5R53E5E 02

Help | Expart | k. Eann::el| gnal_l,lze|

Inverse FFT Analysis Dialog Box

Parameters

IFFT analysis provides the following information on the input channels selected:
FFT Size - The number of data points for which a value is computed.

Maximum Frequency - The maximum frequency for which values are computed.

Delta Frequency - Resolution or spacing between spectral data points. This value is based on the Nyquist
frequency and equals the sample rate divided by 2.

Buttons

Help - Open the InField help system to the topic directly related to Inverse Fast Fourier Transform (IFFT)
Analysis.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be the default.
Cancel - Exit without making any changes or applying any analysis functions.

Analyze - Perform the Inverse Fast Fourier Transform analysis. The IFFT analysis will generate a new channel
under the Output List tab in the Channels List window.
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Filtering

Filtering Procedure
The procedure for performing data filtering is as follows:

NOTE: Filtering dialog boxes are modeless. Clicking outside of a filtering dialog box will allow the use
of other windows and functions in the open InField session. Click on the related dialog to
return to the data filtering function.

1.  Select the channel(s) to be filtered from the InField Channels List.
2. Open the dialog box for the filtering function and set its parameters.
3. Click Analyze to run the filter according to the parameters entered.

When the filter is complete, InField will plot the results, add the output channel to the Output List, and create an
output file in the InField installation Output Files directory.

The title bar of each plot window will have the name of the analysis and the name of the channel being validated.

The default file name for the analysis file containing output channels is made up of the function name and sequence
number with a _SIF extension (SoMat Information File). Sequences start at 000. The sequence number is
determined by the previously created output files for the selected function that exist in the InField installation
Output Files directory. The next available sequence number is used for the newly created file and plot. For example,
if there are existing files titled Filter_000.sif and Filter_001.siT, selecting the Analyze button within a
Digital Filtering dialog will create a file titled Filter_002.sif.

NOTE: Files created in the Output Files directory of the InField installation are not deleted when
InField is exited. Periodic, manual deletion of unnecessary files in this directory is strongly
recommended to conserve disk space on the computer.

4.  Examine the analysis results. Channel plot data can be viewed, edited, copied, and pasted using the functions
described in Viewing Data and Editing Data.

5. Review the Output List. Save the channels to keep, and remove the channels to be discarded.

« To save output channels to a file (other than the default), select them and choose Save As from the File
menu. The saved files will appear in the Output List with the file name specified during the save. The
original, temporary channels can be removed from the Output List.

» To remove channels from the Output list, select the channel(s) to remove then right-click. Use the option
Remove Channel(s) from Channel List to remove the unwanted channels. It is not necessary to
remove the channels from the Output List. This is really just a way to keep the list manageable and avoid
clutter when analyzing data.
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Digital Filtering
The Digital Filtering dialog box is used to configure and apply a Digital Filter.

To start Digital Filtering, either select it from the Filtering sub-menu of the Tools menu or click the Digital Filter

Design button, M on the application toolbar.

=k Digital Filtering %]
Filter Type Filter Drezign FRF
(¢ Bulterwarth frf.sif - Thase
" Finite Impulze Fesponze [FIR] 150 —
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2,
u
(« Low Pazs (" Band Pasz W —50 —
" High Pas= (" Band Stop £ 1004
Filter Parameters ~L504

frf.=sif - Magnitude

Order: g - .

@ -20
2 40
]
. . ﬂ -&0
Filter Cutoff Frequencies E
R i i R
1] a0 -1an I I I I

J J Ii 0 10 Z0 a0 40 E0

Frecquency (Hz)

Help | Expart | (] % Eann::el| Analuze |

Digital Filtering Dialog Box
Parameters

Filter Type
Butterworth or Finite Impulse Response
Zero Phase - Forward and backward Filter

Filter Frequencies - Low pass, high pass, band pass, and band stop

Filter Parameters
The Filters Parameters group box will have one or two parameters to set based upon the filter used.

Order - Integer indicating the filter order. Ranges available are 1 to 40 for Butterworth filters, 1 to 398 for FIR
filters.

The larger the order, the flatter the passband response, the lower the stopband attenuation, and the sharper
the filter rolloff. The trade-offs are increased time for computation and increased phase distortion/delay.
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Window Type - Applies only to Finite Impulse Response Filters (FIR). If you are using a FIR, you need to specify
the type of window to be applied to the filter coefficients. The Filtering module includes four standard
window types:

Uniform - Using Uniform is essentially the same as not using a window at all. Amplitude accuracy can be
affected by as much as 36%.This window is only useful when an integer number of periods of the time
waveform are included in the time block.

Hanning - Hanning is useful for resolving closely-spaced frequencies where amplitude accuracy (18%) is
not important.

Hamming - Hamming is useful for searching operations where good frequency resolution is needed, but
accuracy of amplitude (15%) is not important. It is particularly useful when a large dynamic range
between spectral lines occurs.

Flat Top - Ideal for acute amplitude measurements (+/- 0.1%) of spectral lines that are not closely spaced
(8-10 lines) or where a large dynamic range is needed.

Filter Cutoff Frequencies

Used to determine break frequencies. The top slider is used with all filters; the bottom slider will only be available
when using either the Band Pass or Band Stop filters. Frequency can be specified by using either the scroll bar or
entering a value in the text box to the right of the sliders.

Break frequency values range from 0 Hz to the Nyquist frequency of the first channel selected from the Channel
List.

If the channels selected are sampled at 1 kHz and 2 kHz respectively, and a four-pole, low-pass Butterworth filter
with a cutoff at 500 Hz is designed, the second channel is filtered with a four-pole, low-pass Butterworth filter
with a cutoff at 1 kHz.

Filter Design FRF

Two graphs on the right side of the dialog box show the frequency response functions (FRFs) for the filter. The
top graph will show the phase, while the bottom graph shows the gain or frequency roll-off. These graphs will vary
according to the filter type, response, and cutoff frequency selected.

Once all of the parameters have been entered, click in the area to the right of the Digital Filter dialog box, which
is the area where the graphs will be located. If the filter is feasible, the graphs will then be presented.

Buttons
Help - Open the InField help system to the help topic directly related to Digital Filtering.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be the default.
Cancel - Exit without making any changes, or applying any filtering functions.

Analyze - Run the filter according to the parameters selected. The Digital Filtering dialog will remain visible
behind the plot window that is generated by the analysis. The Digital Filter will generate a new filtered
channel under the Output List tab in the Channels List window.
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Resampling

Resampling provides a method to change the number of samples taken from an input channel. This may be
necessary when using a DataMode to combine two channels that may have been collected using different sample
rates.

To start Resampling, either select it from the Filtering sub-menu of the Tools menu or click the Resampling button,

Iﬂl, on the application toolbar.
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Resampling Dialog Box

Parameters
Current Sample Rate - The current sample rate of the selected channel.

New Sample Rate - The sample rate to which the channel should be modified.

Buttons
Help - Open the InField help system to the topic directly related to Resampling.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use.These parameters will then be the default.
Cancel - Exit the dialog box without making any changes.

Analyze - Perform an analysis according to the parameters provided. The Resample dialog will remain visible
behind the graph that is generated from the analysis. In addition, the Resample will generate a new channel
under the Output List tab in the Channels List window.
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Upsampling

Integer Upsampling Analysis uses linear interpolation to upsample time history data channels by whole integer
multiples in order to bring two or more channels up to the same sample rate.The two primary purposes for this
are 1) so that visual data comparisons (e.g. with Tabular display, OverPlot, MultiPlot, etc.) can be performed and
2) so that channels can be plotted against each other using CrossPlot.

Integer Upsamping works only on Time History channels and uses simple linear interpolation; therefore the
frequency content of the channel(s) is distorted.To preserve frequency content, use Resampling Analysis.

To start Upsampling, select it from the Filtering sub-menu of the Tools menu.
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Upsampling Dialog Box

Parameters
Mode - There are two mutually exclusive modes available in Integer Upsampling Analysis.

Least Common Multiple - Upsample all selected channels to the same sample rate. The sample rate is
computed by finding the least common multiple of all selected channels and is displayed in the "Least
Common Multiple" field. For example, if two channels of sample rates 100 Hz and 60 Hz are selected,
both output channels will have a sample rate of 300 Hz.

The analysis engine will attempt to determine multiples of channels with decimal sample rates, but if
no multiple rate can be determined, the analysis engine will report an error. For example, two
channels with sample rates of 2.5 Hz and 7.5 Hz have a least common multiple of 7.5 Hz. But if two
channels with sample rates of 2.6 Hz and 7.5 Hz are chosen, an error will be generated.

» Caution should be exercised when using "Least Common Multiple" mode, as the resulting output
channels can be quite large. For example, if two channels of sample rates 1000 Hz and 999 Hz are
selected, the channels will be upsampled to the common sample rate of 999000 Hz.

Upsample Factor - Upsample all selected channels by the same whole integer multiple. For example, if
two channels of sample rates 100 Hz and 60 Hz are selected and an upsample factor of 3 is entered,
then the two output channels will have sample rates of 300 Hz and 180 Hz respectively.

Upsample Factor - User-specified factor by which to upsample the selected channel(s). Available only when
selected Mode is Upsample Factor.
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Least Common Multiple - Calculated least common multiple of the sample rate(s) of the selected channel(s).
Applicable only when selected Mode is Least Common Multiple.

Buttons
Help - Open the InField help system to the topic directly related to Integer Upsampling.

Export - Save the information entered directly to an analysis script (*.ANA) file. This makes it possible to rerun
the same analysis with the InField Script Player playback dialog.

OK - Save the information entered for future use. These parameters will then be the default.
Cancel - Exit without making any changes or applying any analysis functions.

Analyze - Perform the Integer Upsample analysis according to the parameters provided. The Integer Upsample
dialog box will remain visible behind the graph that is generated from the analysis. In addition, the Integer
Upsample analysis will generate a new channel under the Output List tab in the Channels List window.
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